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About this topic collection

This PDF has been created from the WebSphere Message Broker Version 6.1
(December 2007) information center topics. Always refer to the WebSphere Message
Broker online information center to access the most current information. The
information center is periodically updated on the [document update]site and this
PDF and others that you can download from that Web site might not contain the
most current information.

The topic content included in the PDF does not include the "Related Links”
sections provided in the online topics. Links within the topic content itself are
included, but are active only if they link to another topic in the same PDF
collection. Links to topics outside this topic collection are also shown, but these
attempt to link to a PDF that is called after the topic identifier (for example,
ac12340_.pdf) and therefore fail. Use the online information to navigate freely
between topics.

Feedback: do not provide feedback on this PDF. Refer to the online information to
ensure that you have access to the most current information, and use the Feedback
link that appears at the end of each topic to report any errors or suggestions for
improvement. Using the Feedback link provides precise information about the
location of your comment.

The content of these topics is created for viewing online; you might find that the
formatting and presentation of some figures, tables, examples, and so on are not
optimized for the printed page. Text highlighting might also have a different
appearance.
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Installing

Installation information for WebSphere® Message Broker is provided in the
WebSphere Message Broker Installation Guide, which is supplied in hardcopy with
your product media.

The [“Installation Guide”| defines hardware and software requirements for
WebSphere Message Broker and its corequisite and prerequisite products. It
describes the tasks that you must complete to prepare for installation, to install
WebSphere Message Broker, and to verify the installation. When you have
completed installation, use this information center to create and configure your
components and the broker domain.

The software and hardware requirements are also provided within this information
center in the [“Installation” on page 31| reference section. This section also includes
information about the support for 32-bit and 64-bit operating modes, and the
changes and additions in Version 6.1.

See [“Finding the latest information” on page 4| for details about how to check that
you have access to the most recent information available.

If product fixes or updates are made available, refer to the following topics for
information about how to apply these:

+ [“Applying service to runtime components” on page 10|

« |“Applying service to the Message Broker Toolkit” on page 13|

To install complementary products including DB2, see [“Installing complementary]
[products” on page 4

Installation Guide

Installation information for WebSphere Message Broker is provided in the
Installation Guide that is supplied in hardcopy with your product package.

The guide provides general preparation, planning, and security information for all
platforms. It also provides installation instructions for distributed systems, and
describes common problems and solutions and the names and locations of the
installation log files. The guide also covers verification programs on Linux® (x86
platform) and Windows®.

If you are installing on z/OS®, the equivalent installation instructions are provided
in the Program Directory that is supplied in hardcopy with your product media.

The Installation Guide does not cover configuration or customization tasks on any
operating system; it describes only how you install the product components onto
your computers. When you have completed installation on distributed systems,
you must initialize the local environment before you can create or configure
resources. This task is described in [‘Setting up a command environment” on page]
6] Environment initialization is not required on z/OS. Refer to [Configuring|
WebSphere Message Broker] for information about how to design and configure
your broker domain on all systems.

The Installation Guide PDF is available in English and in translation:

© Copyright IBM Corp. 2000, 2007 3



* On the Quick Start CD
+ In the [I[BM Publications Center|

You can view, search, and print PDF files using Adobe® Acrobat® Reader. To
download Acrobat Reader, visit the|[Adobe Systems Inc|Web site.

Finding the latest information

Access the latest information for WebSphere Message Broker.

The following information is provided:

Requirements Web site
For the latest details of hardware and software requirements on all
supported platforms, visit the [WebSphere Message Broker Requirements|
Web site.

readme.html
The product readme file is frequently updated and includes information
about last minute changes and known problems and workarounds. The file
is included on the product media and is installed when you install product
components. The latest version is always on the [product readmes| Web
page; always check to see that you have the latest copy.

Installation Guide
The Installation Guide is provided in hardcopy with your product. It is
also available on the IBM® Publications Center Web site. See
[Guide” on page 3| for instructions about how to access this site to view the
guide online or check whether a later edition of the guide is available.

Information center
This information center is installed with the Message Broker Toolkit, and
updates are typically included when you apply service to that component.

The information center is periodically updated independently of the code,
and you can install the latest level from within the toolkit. See
lservice to the Message Broker Toolkit” on page 13| for instructions about
installing code and documentation updates.

Support information
The [WebSphere Message Broker support Web page] is regularly updated
with the latest product support information. For example, if you are
migrating from an earlier version, look under the heading "Solve a
problem” for the document "Problems and solutions when migrating”.

Installing complementary products

WebSphere Message Broker works with several other products to provide
complementary services.

If you want to make use of these optional services in your WebSphere Message
Broker environment, refer to the following installation information:

* [[BM DB2°
+ [IBM Tivoli® License Manager|
+ [Eclipse plug-ins from another vendor]
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Installing IBM DB2

IBM DB2 Enterprise Server is one of the supported databases for use with
WebSphere Message Broker.

Other editions of DB2 that are stated to be suitable for production deployment are
also supported. For a full list of supported databases and versions, from IBM and
other vendors, see [“Supported databases” on page 37|

On Windows only, the Derby database is embedded in the broker component. It is
suitable for verification and evaluation only, and is enabled when you install the
ODBC Drivers from the Launchpad as part of the WebSphere Message Broker
product installation. For production systems, you must install one of the supported
databases, for example, DB2 Enterprise Server. For information about how to
install ODBC Drivers as part of the WebSphere Message Broker installation, see the
[“Installation Guide” on page 3.

For distributed systems, DB2 Enterprise Server Version 9.1 is supplied on DVD (for
Linux (x86 platform) and Windows only) and on CD with WebSphere Message
Broker. DB2 can be installed either before or after you have installed WebSphere
Message Broker. To install DB2, see the install.html file in the /doc directory on the
CD or DVD. The supplied version is subject to restricted terms and conditions for
use with WebSphere Message Broker. Help is provided by the installation wizard
following license acceptance.

For z/0OS systems, either DB2 Version 8.1 or DB2 Version 9.1 is required, but no
other databases are supported. You must install DB2 before you install WebSphere
Message Broker on z/OS systems.

Installing Tivoli License Manager

IBM Tivoli License Manager (ITLM) enables you to monitor the usage of IBM (and
other) software products. WebSphere Message Broker includes support for ITLM
Version 2.1.

Use ITLM to perform the following software auditing functions:
* Monitor the licenses used across different machines.

* Help keep unnecessary licenses to a minimum.

* Guard against software license compliance problems.

If you are using one or more of the WebSphere Adapters with WebSphere Message
Broker, you must activate ITLM to include those adapters, for example in

monitoring activities. If you require this support, follow the instructions in
[Activating ITLM for WebSphere Adapters]

To find out more about using ITLM to monitor usage of WebSphere Message
Broker and other IBM products, or to purchase ITLM, see the [[BM Tivoli License]
[Manager Web site}]

For information about installing this product, see the [[BM Tivoli License Manager]
[information center]|

Installing plug-ins using Eclipse Update Manager

Use Eclipse Update Manager to install and update plug-ins provided by partners
and other software vendors.
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Do not use the Eclipse Update Manager to update or install plug-ins that are
managed by IBM Installation Manager. Always use Installation Manager to work
with products that are installed with Installation Manager. For other products, use
Eclipse Update Manager, but follow the restrictions and guidance provided:

* Do not delete the platform.xml file to prompt Eclipse to regenerate the file. The
regenerated contents will be incomplete and therefore invalid.

* Always save a backup copy of your platform.xml file before you make any
changes to your configuration, for example by using Eclipse Update Manager to
install or update plug-ins that are provided by another software vendor.

* When you use Eclipse Update Manager (graphical interface or command line),
always specify the package group directory as the destination; never specify the
shared resource directory. The shared resource directory is managed by
Installation Manager and is reserved for its use.

* Do not use Eclipse Update Manager to search for updates for features that you
have installed using Installation Manager.

* Do not select Clean up all configuration errors in the Eclipse Update Manager
interface; this option might lose information that is maintained by Installation
Manager.

Setting up a command environment

After you have installed the product on any of the distributed systems, you must
initialize the environment before you can use any runtime component or
command.

You should also complete this task if you have migrated to WebSphere Message
BrokerVersion 6.1 from a previous version. A profile is provided to help you set up
the environment.

If appropriate, you can extend the initialization performed by this profile; for
example, for broker or user databases, or for other products that you want to use
within the broker.

You must ensure that you run this profile each time you run one of the
administrative commands, or start a component; for example, a broker.

For information on setting up your command and runtime environment on a
Windows system, see [‘Command environment: Windows platforms”/|

For information on setting up your command and runtime environment on Linux
and UNIX® systems, see ["Command environment: Linux and UNIX systems” on|
|o; e §

Command environment: Windows platforms

Set up the Windows environment to run WebSphere Message Broker commands.

On Windows platforms, the components run as services, therefore they do not
inherit the environment that is set for the command prompt from which you start
them. The components run the mgsiprofile command when they start, which
completes the environment initialization.

The mgsiprofile command is located in the directory install_dir\bin. You must not
change the location of the mgsiprofile command, or make user modifications to the

command, because it might be replaced if you install service, or an update, to the
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product. If you need to run your own settings, add one or more command files
called your_file_name.cmd to the directory workpath\common\profiles.

When mgsiprofile runs, it automatically calls any additional user-written scripts in
this directory.

A typical reason for adding scripts is [“Running database setup scripts.”|

When you have configured any additional setup, you can use one of the following
methods to initialize the runtime environment for components and commands:

1. If you have only one installation of the runtime product, open a Command
Console by clicking Start » IBM > WebSphere Message Brokers 6.1 »
Command Console. The mgsiprofile command initializes the environment and
invokes any additional scripts in the common\profiles directory.

2. If you have one or more installations of the runtime product, open a command
prompt window. Locate and run the mgsiprofile.cmd script in the directory in
which you installed the appropriate product. The mgsiprofile command
initializes the environment and invokes any additional scripts in the
common\profiles directory.

Check whether the following conditions apply to your environment:

 If you have a previous version of the product on this system, ensure that you
run the correct profile before using Version 6.1. The mgsiprofile command places
the Version 6.1 commands and libraries at the front of your search path, and
invokes any user profiles that you have supplied which can override any
combination of PATH, CLASSPATH, or library PATH.

* If you use the same user ID, and you run multiple profiles (from multiple
different installations or versions), you might get unexpected results. Log off and
log on again before you run the specific profile that you require.

Running database setup scripts

A broker requires access to a database to maintain operational and state data, and
might also require access to user databases from deployed message flows.

When you install a database product on Windows, the relevant settings are
typically made to the system environment. However, some database managers
provide a profile to perform this setup, or provide details of actions that you must
take in their documentation. Always check the database product documentation for
environment setup details; the information provided here is for general guidance
only.

If a profile is provided for the database that you are using, complete the following
steps:

1. If you can update the profile to provide permanent values for the details that
are required (for example, the database server name or the installation
directory):

a. Complete the changes to the database profile.
b. Copy the profile file to the directory workpath\common\profiles.

2. If you cannot update the profile permanently, but need to make changes each
time, you must run it independently of the mgsiprofile command before you
start the component.
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When your environment has been set up, see |Configuring databases| for
information about setting up your databases for use with the broker.

Command environment: Linux and UNIX systems

On Linux and UNIX systems, when you start a runtime component it inherits the
environment from where you issue the command.

You must therefore initialize the environment before you start a component; the
command mgsiprofile located in the directory install_dir/bin, performs this
initialization. If you are starting a broker, you might also need to initialize the
environment for any databases that are accessed by the broker.

You must not change the location of the mgsiprofile command, or make user
modifications to the command, because it might be replaced if you install service,
or an update, to the product. If you need to run your own additional environment
settings, add a script called your_file_name.sh to the profiles directory:

workpath/common/profiles

When mgsiprofile runs, it automatically calls these additional user-written scripts.

Two typical reasons for adding scripts are [‘Running database setup scripts” onl|
[page 9| and [“Running with Java 5” on page 10

When you have configured any additional setup, you can initialize the runtime
environment for components and commands:

1. Issue the mgsiprofile command:
. install_dir/bin/mgsiprofile

You must include the period and space preceding the location for this
invocation to work correctly. Add this command to your login profile if you
want it to be run at the start of every session.

This command accesses additional scripts that you have copied to the
common/profiles directory, therefore the environment is initialized for runtime
components and other resources such as databases.

2. Start the components that you want to run on this system using the mqsistart
command.

Check if the following conditions apply to your environment:

* If you have a previous version of the product on the system, ensure that you
run the correct profile before using Version 6.1. The mgsiprofile command places
the Version 6.1 commands and libraries at the front of your search path, and
invokes any user profiles that you have supplied which can override any
combination of PATH, CLASSPATH, or library PATH.

* If you use the same user ID, and you run multiple profiles (from multiple
different installations or versions), you might get unexpected results. Log off and
log on again before you run the specific profile that you require.

* 64-bit ODBC settings on Linux and UNIX systems are found in a text file
defined by the ODBCINI environment variable. Set ODBCINI to point to a copy of
the sample file install_dir/ODBC64/V5.0/0dbc64.ini (on the HP-UX
(PA-RISC platform)) or install_dir/ODBC64/V5.2/0dbc64.ini (on all other
platforms).

* 32-bit ODBC settings on Linux and UNIX systems are found in a text file
defined by the ODBCINI32 environment variable. Set ODBCINI32 to point to a copy
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of the sample file install_dir/ODBC32/V5.0/0dbc32.ini (on the HP-UX
(PA-RISC platform)) or install_dir/ODBC32/V5.2/0dbc32.ini (on all other
platforms).

Running database setup scripts

A broker requires access to a database to maintain operational and state data, and
might also require access to user databases from deployed message flows.

When you install a database product on Linux and UNIX systems, some database
managers provide a profile to perform the environment set up that the database
requires, or provide details of actions that you must take in their documentation.
Always check the database product documentation for environment setup details;
the information provided here is for general guidance only and might not be
complete.

If you have installed 64-bit instances of DB2, Informix, or 64-bit Oracle databases,
you need to complete additional setup steps, including adding 32-bit libraries to
MQSI_LIBPATH32. Detailed instructions are provided in[Setting your environment|
[to access 32 bit databases] [Creating a DB2 database on Linux and UNIX systems,
and [Connecting to a database from Linux and UNIX systems: 64-bit considerations]

1. If you can update the profile to provide permanent values for the details that
are required (for example, the database server name or the installation
directory):

a. Complete the changes to the profile.
b. Copy the profile file to the directory workpath\common\profiles.

2. If you cannot update the profile permanently, but need to make changes each
time, you must run it independently of the mqsiprofile command:

a. Run the appropriate profiles to initialize the environment for the database:
* For DB2, issue the following command for the relevant DB2 instance:
. db2_instance_directory/sql1ib/db2profile

 For Oracle, export ORACLE_HOME and ORACLE_SID, then issue the following
command:

. ${ORACLE_HOME}/bin/oraenv

* For Sybase, issue the following command, specifying your installation
directory:

. Sybase_installation_directory/SYBASE.sh

* For Informix, check the documentation for the client on your broker
system for details of the actions that you must take. For example, you
might have to specify the following environment variables:
export INFORMIXDIR=/installation _directory of_informix_client_software
export PATH=${INFORMIXDIR}/bin:${PATH}
export INFORMIXSERVER=server_name
export INFORMIXSQLHOSTS=${INFORMIXDIR}/etc/sqlhosts
export TERMCAP=${INFORMIXDIR}/etc/termcap
export TERM=vt100
export LIBPATH=${INFORMIXDIR}/1ib:${INFORMIXDIR}/1ib/esql:

${INFORMIXDIR}/1ib/c1i:$LIBPATH
where server_name is defined in the file sqlhosts (the required value is
typically the machine name), and the location of the file sqlhosts is set up
as part of the installation process.

To configure your system to run this setup at the start of every session,
add these statements to the login profile of the user that is going to run
the broker.
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When your environment has been set up, see |Configuring databases| for
information on setting up your databases for use with the broker.

Running with Java 5
WebSphere Message Broker supplies Java version 5 (also known as version 1.5).

To check what level of Java you are currently working with, enter the following
command:

java -fullversion

Applying service to runtime components

Apply maintenance and program fixes to the product components.

You cannot back out service without removing the entire product. Keep a backup
image or previous GA CD or fix pack readily available in case you encounter any
problems after installing service.

Before you apply service to any component, check if you want to back up any
associated resources. For details of this task, see [Backing up resources]

Maintenance updates for WebSphere Message Broker are available through a
download from a web site, in the form of a Program Temporary Fix (PTF), also
known as a fix pack. Fix packs are cumulative, therefore you do not need to install
Fix Pack 1 before you can install Fix Pack 2. However, the GA code must have
been installed first to activate the licensing requirements. You can find the latest
information about available fix packs on the [WebSphere Message Broker support|

Fix packs for WebSphere Message Broker are installed using the same technology
as for the GA release. Therefore product files are consistently tracked and updated
appropriately.

You cannot remove individual fix packs; you can uninstall only the entire product.
If you want to restore a system to a previous service level, you must uninstall the
entire product, reinstall the GA level of the product, and then install the desired
level of fix pack.

If you have any interim fixes applied to your existing installation, contact your
IBM Service representative for instructions and possible updated interim fixes for
the fix pack level you are installing.

You can download the latest fix pack from the [WebSphere Message Broker support]
. Scroll down the page and select the fix pack listed for your WebSphere
Message Broker product.

To download maintenance updates:

1. Read the multiplatforms memo. To access the memo, scroll down to read the
Installation Instructions. Click the link Problems fixed (MEMO.PTF).

2. To begin the download process, scroll to Download package and click the
HTTP download option. Accept the download terms and conditions and sign
in to the download site. Click the link for your desired operating system (with
name of the form Fix Pack XX Unnnnnn, where XX is the number of the fix
pack, and Unnnnnn is the fix pack file name) and follow the instructions.
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3. Select a suitable destination as the target for download.

Choose the relevant operating system for instructions about how to apply
maintenance updates:

Windows]
Linux and UNIX]

Z/O§|

Installing service on Windows

Apply maintenance updates and program fixes to product components.

Before applying a maintenance update to WebSphere Message Broker, download
the update as described in [“Applying service to runtime components” on page 10|

To install the updates that you have downloaded:

1.

Ensure that the user ID you are logged on with is a member of the Windows
Administrator group in the local security domain. If you can, use the same user
ID as the one that you used for installing WebSphere Message Broker.

Ensure that all WebSphere Message Broker function is stopped:

a. Stop execution of the Configuration Manager, the User Name Server, and all
brokers on this system using the [mgsistop command} or by stopping the
Windows services for these components from Start > Settings » Control
Panel » Administrative Tools »> Services.

b. Stop execution of the workbench
c. Ensure that you do not have any WebSphere Message Broker files open.

Exit all Windows programs before applying maintenance to WebSphere
Message Broker to ensure data is not lost.

Change to the directory into which you downloaded the fix pack file
(Unnnnnn.exe).

In Windows Explorer, right-click the fix pack file and select Open.
Alternatively, enter the following command at a command prompt:

FixPackLauncher [-s] -a install_arguments

where
FixPackLauncher is the full path to the fix pack executable file, for example
U200208.exe.
-s is optional, and indicates that the fix pack launcher extracts updates
silently. If you omit this option, a progress of extraction panel is displayed.
-a install_arguments is optional, provides the arguments that determine
how the installer runs.

For more information about installation arguments, see [‘Modes of installation|
land uninstallation” on page 47 The installer extracts the update files and runs
automatically according to your chosen arguments.

Follow the instructions presented by the installation program and provide any
input that is required to complete the installation.

When you have completed installation, review the multiplatform memo that is
supplied in the directory readmes, and complete any manual post-installation tasks
that are required.

Installing service on Linux and UNIX
Apply maintenance updates and program fixes to product components.
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Before applying a maintenance update to WebSphere Message Broker, download
the update as described in [“Applying service to runtime components” on page 10

To install the updates that you have downloaded:

1.
2.

Stop all components that are running.

Change to the directory where you downloaded the fix pack file,
Unnnnnn.tar.z.

Replace the .Z file with a .tar file, by entering the following command:
uncompress -fv filename.tar.Z

Untar the image and extract all the directories, subdirectories, and files required
to apply the update, by entering the following command:

tar -xvf filename.tar

Decide which mode of installation you want to use. The choices are explained
in [“Modes of installation and uninstallation” on page 47

Depending on the mode of installation you have decided to use, run one of the
commands described below, where installer is the appropriate installation
program for your platform, listed in the table below.

* To invoke the installation wizard in graphical mode, double-click the file or
type its name with no options at a command prompt and press Enter. When
you invoke the installation wizard, it guides you through a series of panels
where you can make choices about where to install the components, and
which components you want to install.

* Enter one of the following commands to invoke the installation wizard in
console mode. Enter installer -console for a default invocation. Include the
absolute or relative path names if you invoke installation from a directory
other than the one in which the wizard exists. When you invoke the
installation wizard, it prompts you to indicate where to install the
components, and which components you want to install.

¢ The command shown below invokes the installation wizard to complete a
typical installation with all default settings. Include the absolute or relative
path names if you invoke installation from a directory other than the one in
which the wizard exists. If you want to specify non-default settings, you
must include a response file on the invocation. for more details of how to do
this, and how to create and edit a response file to define your requirements,
see [“Using response files with runtime components” on page 49

Platform Installation program

AIX® setupaix

HP-UX (Integrity platform) setuphpiab4

HP-UX (PA-RISC platform) setuphp

Linux (POWER™ platform) setuplinuxppc

Linux (x86 platform) setuplinuxia32

Linux (x86-64 platform) setuplinuxx64

Linux (zSeries® platform) setuplinux390x

Solaris (SPARC platform) setupsolaris

Solaris (x86-64 platform) setupsolarisx86

The installer extracts the update files and runs automatically according to your
chosen arguments.

Follow the instructions presented by the installation program and provide any
input that is required to complete the installation.
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When you have completed the installation, review the multiplatform memo
supplied in the readme directory, and complete any manual post-installation tasks
that are required.

Installing service on z/0OS
Apply maintenance updates to WebSphere Message Broker.

If your SMP/E target zones are not on the same file system as your production
directories, copy the directories as a whole to the system where they are to be
used, and replace the directories currently there. When you complete this action,
the User Name Server and any brokers use the updated directories when they next
restart.

If you do not want all of your brokers to be affected by changing the directories,
you need to have at least two copies of the product directories. Copy the updated
files to the first copy and run one or more brokers with these directories. When
you are satisfied with the updates, copy the updated files to the second copy of the
directories for the rest of your brokers to use.

Use the following steps to back up your WebSphere Message Broker directories on
z/0S , and restore them on another system or on the same system in a different
directory:

1. Compress the code files using the command:
tar -cvozf mgsi.tar.z /usr/lpp/mgsi

where /usr/lpp/mgsi is the installation path.

2. FTP the tar file to the new file system in binary mode by entering the following
commands:

ftp machine_name
binary
cd USS_path_for_storing_tar_file
put mgsi.tar.z
quit
3. Extract the contents of the file using the following command:
tar -xvozf mgsi.tar.z

Because the initial tar command used the absolute path
/usr/1pp/mqsi

you need WRITE access to the root directory for this task. You can use a
relative path instead. See the tar command in the UNIX System Services
Command Reference Guide for more details.

Applying service to the Message Broker Toolkit
Apply fixes and upgrades to the Message Broker Toolkit.

Before you apply service to the Message Broker Toolkit, you might want to
preserve the resources that you have created or imported into Version 6.1. For
details of this task, see [Backing up the Message Broker Toolkit workspace}

To apply service on Linux (x86 platform), your user ID must have root authority.
Follow your local security guidelines to acquire root authority; either log in as root,
or log in as another user and become root. On Windows, your user ID must have
Administrator authority.
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The Message Broker Toolkit uses IBM Installation Manager to install service
updates. Follow these instructions to install all available updates to the Message
Broker Toolkit. Occasionally updates to the information center are also made
available, and you can also apply these updates using the instructions here.

If you want Installation Manager to retrieve updates from a different location, see
[‘Changing the update repositories.”] If you use FTP or HTTP proxies to allow
applications to access the Internet, see [‘Setting FTP and HTTP proxies” on page 15|

1. Start the Installation Manager:
e From the Linux main menu or the Windows Start menu:

— On Linux, you can use this option only if you are logged in as root. If you
have logged in as another user, you cannot use the main menu links, even
if you become root.

- On Red Hat, click System » IBM Installation Manager.
- On SUSE, click System Tools » IBM Installation Manager.

— On Windows, click Start » Programs » IBM Installation Manager » IBM
Installation Manager.

* Navigate to the eclipse subdirectory in the directory in which Installation
Manager is installed and run the following command:

- IBMIM
— TS IBMIM.exe

Installation Manager opens and displays its initial panel.
2. Click Update Packages, then select the package group in which you have
installed the Message Broker Toolkit.

3. Click Next. Installation Manager searches the selected update site or sites, and
displays a list of available updates for the products and features that you have
installed.

Initially Show recommended (below the list) is selected, and the latest updates
only are shown. To include earlier updates as well, select Show all.

See|“Changing the update repositories”| for information about how you can
change the locations that are searched.

4. Select the updates that you want to apply and click Update. The updates are
applied.

5. Click OK to return to the Installation Manager initial panel.
6. Click File » Exit to end Installation Manager.

Changing the update repositories

If you have a large number of Message Broker Toolkit users, or your users do not
have regular access to the Internet, you might find it more convenient to download
updates to a local site or server, and modify Installation Manager to access the
updates at that alternative site.

You might take this action to limit Internet access, or to reduce download times, or
both.

Complete the following steps:

1. Start Installation Manager, as shown above. Installation Manager opens and
displays its initial panel.

2. Click File » Preferences. The Preferences dialog is displayed.
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3.
4.

Click Repositories in the left pane. The Repositories page is displayed.

Click Add Repository. If you know the name and location of the update
repositories that Installation Manager is to search, enter the URL or fully
qualified location of the update file, including the repository name, for example
repository.config.

To search for repositories, which can be on a local or a remote computer, click
Browse and navigate to the correct location. The field File of type lists the
values repository.config, diskTag.inf, jar, and .zip, and repositories with these
names and types are searched for by default. The identity of an update
depends on what type of update it is (for example, disk images are named
diskTag.inf),

If you are not sure what updates you might want, leave the contents of field
File of type unchanged; all available updates are shown. Click the required
repository to select it, then click Open. The repository is added to the displayed
list of repositories. If the repository is not connected, a red cross is displayed in
the Connection column. You might need to check your network connections, or
try again at a later time.

When it is added to the list, the repository is initially shown as selected, to
indicate that its contents will be included when you run Installation Manager
to update packages.

Repeat this step to add additional repositories if appropriate from the same or
another location. You can have one or more locations selected at any time;
Installation Manager searches all selected repositories listed on the Repositories
page.

If you want Installation Manager to search only the repositories that you have
added, clear Search service repositories during installation and update. The
service repositories are those locations on the product support Web sites that
host updates. If you clear this option, the default service repositories are not
searched. The service repositories location is fixed and predefined; you cannot
change it.

Click OK on the Browse panel if you opened it, and click OK on the
Repositories page.

Click Apply to confirm the update, then click OK to close the Preferences
dialog.

To remove a repository from the selected list, clear its selection. If you want to
delete a repository in the list, select the repository and click Remove Repository.
To clear selection of all listed repositories, click Clear Credentials.

Setting FTP and HTTP proxies

If your environment has a firewall, or uses proxies to control access to the Internet,
you can change the Installation Manager settings.

You do not have to complete this task if you have changed the Installation
Manager repository location to a local site.

Complete the following steps:

1.

2.
3.

Start Installation Manager, as shown above. Installation Manager opens and
displays its initial panel.
Click File » Preferences. The Preferences dialog is displayed.

Expand the Repositories tree in the left pane, and select Ftp Proxy or Http
Proxy.
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4. Select Enable proxy server and enter the details in the entry fields that are
required for the protocol that you selected.

5. Click Apply to confirm the updates, then click OK to close the Preferences
dialog.
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Uninstalling

This section describes the following tasks:

“Uninstalling runtime components”]

“Uninstalling the Message Broker Toolkit” on page 23|

You might also want to uninstall complementary products. See the documentation
provided by those products to complete this task:

IBM DB2: Access the appropriate information for your installation:
— |[DB2 V9 information center (distributed systems)
— |DB2 V8 information center (distributed systems)
- [DB2 information center (z/OS)| (Versions 8 and 9)

IBM Tivoli License Manager: access the [[BM Tivoli License Manager information|

Uninstalling runtime components

Uninstall the runtime components on distributed systems.

This section describes this task for the following systems:

AIX
HP-UX
Linux
Solaris
Windows

If you are uninstalling on Linux or UNIX systems, make sure that the directory
/var is not full; the uninstallation wizard requires space in this directory while it is
running.

1.

Decide which mode of uninstallation you want to use. The choices are
explained in [“How to install and uninstall runtime components” on page 47

Follow the uninstallation instructions provided in the corresponding topic:
* [“Uninstalling runtime components in graphical mode”]

+ [“Uninstalling runtime components in console mode” on page 21|

* [“Uninstalling runtime components in silent mode” on page 22|

If, in exceptional circumstances, the uninstall wizard fails to remove the product
successfully, you can remove the product manually. Contact your IBM Service
Center for assistance if a failure occurs.

For information about removing service updates, see [“Uninstalling service for|

[runtime components” on page 23

Uninstalling runtime components in graphical mode

Remove the runtime components using the graphical interface.

Do not use the uninstallation program that is provided by the operating system;
for example, geninstall on AIX, or swremove on HP-UX. Always use the
WebSphere Message Broker uninstall wizard to remove product components, as
described in this topic.
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Because of a known restriction, the uninstall wizard is not created under some
circumstances on HP-UX systems running Version 11.23 only, and on Linux
(POWER platform) systems. If this situation occurs, use the alternative command
shown in these instructions. Also check the readme.html file to ensure that no
additional operating systems are affected by this restriction.

For information about graphical mode and alternative modes available, see
[to install and uninstall runtime components” on page 47|

To invoke the uninstaller in graphical mode, complete the following steps:

1. Stop all running processes that are associated with runtime components
(broker, Configuration Manager and User Name Server) before you uninstall.
Use the [mgsilist (list resources) command|to check which components are
running. Use the [mgsistop command|to stop each component.

2. On Windows and Linux (x86 platform), end all active sessions of the Message
Broker Toolkit.

3. If you do not plan to reinstall on this computer, delete all the brokers
(mgsideletebroker command), Configuration Managers (mgsideleteconfigemer]
Igommandb, and User Name Servers (mgsideleteusernameserver command) that
are associated with this installation. When you delete a component, all its
associated data and resources are deleted; if you want to retain component
data, do not delete that component.

4. If you have created DB2 or Derby databases on Windows with the
[mgsicreatedb command} delete them with the jmgsideletedb command} If you
delete the last database, the Database Instance Manager is also deleted (the
Database Instance Manager controls all appropriate databases in a single
system; if you have another installation, this component might not be deleted if
databases that are associated with the other installation remain). Databases that
have been created by the Default Configuration wizard can also be deleted in
this way.

5. Run the following command from outside the installation directory, specifying
the full path (this method of invocation ensures that the full directory structure
is removed during uninstallation):

¢ On HP-UX systems running Version 11.23 only, and on Linux (POWER
platform) systems:

/install_dir/_uninst_runtime_jvm/jre/bin/java -jar /install_dir/_uninst_runtime/uninstall.jar
* On all other operating systems:

install_dir/_uninst_runtime/uninstaller
where install_dir is the home directory of your WebSphere Message Broker
installation.

If you accepted the default location during installation, this directory is as
follows:

* On Windows, C:\Program Files\IBM\MQSI\6.1
* On AIX, HP-UX, and Solaris, /opt/IBM/mqsi/6.1
* On Linux, /opt/ibm/mgqsi/6.1

Alternatively, if you have a single installation of runtime components on
Windows, you can navigate to Start > Settings » Control Panel > Add/Remove
Programs. Select WebSphere Message Broker and click Change/Remove. The
uninstaller is launched in graphical mode.

6. Choose the component or components that you want to uninstall and follow
the prompts to complete uninstallation.
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Uninstalling runtime components in console mode

Remove the runtime components using the command line interface.

Do not use the uninstallation program that is provided by the operating system;
for example, geninstall on AIX, or swremove on HP-UX. Always use the
WebSphere Message Broker uninstall wizard to remove product components, as
described in this topic.

Because of a known restriction, the uninstall wizard is not created under some
circumstances on HP-UX systems running Version 11.23 only, and on Linux
(POWER platform) systems. If this situation occurs, use the alternative command
shown in these instructions. Also check the readme.html file to ensure that no
additional operating systems are affected by this restriction.

For information about console mode and alternative modes available, see
finstall and uninstall runtime components” on page 47|

To invoke the uninstaller in console mode, complete the following steps:

1. Stop all running processes that use any part of WebSphere Message Broker
(brokers, Configuration Manager, and the User Name Server) before you
uninstall. Use the [mgsilist (list resources) command] to check which components
are running. Stop each component using the [mgsistop command}

2. On Windows and Linux (x86 platform), end any active sessions of the Message
Broker Toolkit.

3. If you do not plan to reinstall on this computer, delete all the brokers
(mgsideletebroker command), Configuration Managers (mgsideleteconfiemer]
I(_‘ommandb, and User Name Servers (mgsideleteusernameserver command) that
are associated with this installation. When you delete a component, all its
associated data and resources are deleted; if you want to retain component
data, do not delete that component.

4. If you have created DB2 or Derby databases on Windows with the
[mgsicreatedb command} delete them with the jmgsideletedb command| If you
delete the last database, the Database Instance Manager is also deleted (the
Database Instance Manager controls all appropriate databases in a single
system; if you have another installation, this component might not be deleted if
databases associated with the other installation remain). Databases created by
the Default Configuration wizard can also be deleted in this way.

5. Invoke the uninstallation program from outside the installation directory,
specifying the full path to ensure that the folders are removed during
uninstallation.

¢ On HP-UX systems running Version 11.23 only, and on Linux (POWER
platform) systems:

/install_dir/_uninst_runtime_jvm/jre/bin/java -jar /install_dir/_uninst_runtime/uninstall.jar -console
* On all other operating systems:
install _dir/ uninst_runtime/uninstaller -console
where install_dir is the home directory of your WebSphere Message Broker
installation.

If you accepted the default location during installation, this directory is as
follows:

* On Windows, C:\Program Files\IBM\MQSI\6.1
* On AIX, HP-UX, and Solaris, /opt/IBM/mqsi/6.1
* On Linux, /opt/ibm/mgqsi/6.1
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6. When invoked, the uninstaller presents text-based screens on the console.
Navigate between these screens using the following options:

* 1 next

* 2 previous
* 3 cancel

* 4 redisplay

The uninstaller asks you to confirm that you want to uninstall the product and
that the location it is uninstalling from is correct. When you have responded to
these questions, the uninstallation starts.

Uninstalling runtime components in silent mode
Remove the runtime components without user interaction.

* Do not use the uninstallation program that is provided by the operating system;
for example, geninstall on AIX, or swremove on HP-UX. Always use the
WebSphere Message Broker uninstallation wizard to remove product
components, as described in this topic.

* If you use silent mode to uninstall runtime components, the wizard always
uninstalls components from the last known Version 6.1 installation location (that
is, the most recent installation), regardless of the location of the uninstallation
wizard that you invoke.

If you want to remove components from an earlier Version 6.1 installation, use
console or graphical mode.

* Because of a known restriction, the uninstallation wizard is not created under
some circumstances on HP-UX systems running Version 11.23 only, and on Linux
(POWER platform) systems. If this situation occurs, use the alternative command
shown in these instructions. Also check the readme.html file to ensure that no
additional operating systems are affected by this restriction.

You can remove WebSphere Message Broker without user interaction. This process
is called unattended (or silent) removal. This topic describes how to run the
uninstallation program in silent mode without a response file; the program
assumes all the default values.

If you want to complete a silent uninstallation, but have non-default requirements,
you can use a response file. A response file is a text file that contains values for the
options that you select when you uninstall WebSphere Message Broker. For more
details of how to create, edit, and employ a response file to specify your
requirements, see [Using response files|

For information about silent mode and alternative modes available, see
finstall and uninstall runtime components” on page 47|

To invoke the uninstaller in silent mode, complete the following steps:

1. Stop all running processes that use any part of WebSphere Message Broker
(brokers, Configuration Manager, and the User Name Server) before you
uninstall. Use the [mgsilist (list resources) command] to check which components
are running. Stop each component using the [mgsistop command}

2. On Windows and Linux (x86 platform), end any active sessions of the Message
Broker Toolkit.

3. If you do not plan to reinstall on this computer, delete all the brokers
(mgsideletebroker command), Configuration Managers (mgsideleteconfiemer]
Igommand|b, and User Name Servers (mgsideleteusernameserver command) that
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are associated with this installation. When you delete a component, all its
associated data and resources are deleted; if you want to retain component
data, do not delete that component.

4. If you have created DB2 or Derby databases on Windows with the
[mgsicreatedb command} delete them with the mgsideletedb command] If you
delete the last database, the Database Instance Manager is also deleted (the
Database Instance Manager controls all appropriate databases in a single
system; if you have another installation, this component might not be deleted if
databases associated with the other installation remain). Databases created by
the Default Configuration wizard can also be deleted in this way.

5. Run the following command from outside the installation directory, specifying
the full path (this method of invocation ensures that the full directory structure
is removed during uninstallation):

* On HP-UX systems running Version 11.23 only, and on Linux (POWER
platform) systems:

/install _dir/_uninst_runtime_jvm/jre/bin/java -jar /install dir/ uninst_runtime/uninstall.jar -silent
* On all other operating systems:
install_dir/_uninst_runtime/uninstaller -silent
where install_dir is the home directory of your WebSphere Message Broker
installation.
If you accepted the default location during installation, this directory is as
follows:
* On Windows, C:\Program Files\IBM\MQSI\6.1
* On AIX, HP-UX, and Solaris, /opt/IBM/mqsi/6.1
* On Linux, /opt/ibm/mqsi/6.1

The uninstallation program runs without interaction.
Uninstalling service for runtime components

You cannot remove a service package without uninstalling the entire product.

If you want to restore a system to a previous service level, you must uninstall the
product before you reinstall the desired level of service. You do not need to
reinstall the GA level of the product first, because the update package does this for
you. No data is lost during this process.

You can have more than one instance of WebSphere Message Broker installed on a
machine. These different installations can be at different levels. Therefore it is not
necessary to uninstall an instance of the product to replace it with an installation at
an earlier level. For further information, see [Coexistence with previous versions|
[and other products]

Uninstalling the Message Broker Toolkit

Choose how you want to uninstall the Message Broker Toolkit.
The Message Broker Toolkit can be installed on the following systems:
* Windows

¢ Linux (x86 platform)

To uninstall the Message Broker Toolkit on Linux (x86 platform), your user ID
must have root authority. Follow your local security guidelines to acquire root
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authority; either log in as root, or log in as another user and become root. On
Windows, your user ID must have Administrator authority.

When you uninstall the Message Broker Toolkit, entries are removed from the
system menus:

If you have installed the Message Broker Toolkit more than once on
Linux (x86 platform), the main menu shows a single entry, regardless of the
number of installations that you have completed; the entry always accesses the
last installation that you completed. When you uninstall this component, the
single entry is removed, and you cannot access remaining installations using
the main menu. Navigate to the correct package group installation directory
and start the Message Broker Toolkit from the command line.

BTN Entries in the Windows Start menu are grouped by package group.
When you uninstall this component, the entry within the appropriate package
group is correctly removed.

Complete the following steps to uninstall the Message Broker Toolkit:

1. Decide which mode of uninstallation you want to use. The choices are
lained in ["How to install and uninstall the Message Broker Toolkit” on page]

2. Follow the instructions provided in the corresponding topic:

+ [“Uninstalling the Message Broker Toolkit in graphical mode”]

* [“Uninstalling the Message Broker Toolkit in silent mode” on page 25|

Uninstalling the Message Broker Toolkit in graphical mode

The graphical interface guides you through the process of uninstalling the Message
Broker Toolkit.

For information about the modes that are available, see [“How to install and|
[uninstall the Message Broker Toolkit” on page 51

Complete the following steps:
1. Log on to the computer on which Message Broker Toolkit is installed:

. Your user ID must have root authority. Follow your local security
guidelines to acquire root authority; either log in as root, or log in as another
user and become root.

« WM Your user ID must have Administrator authority.

2. Start IBM Installation Manager.

. Choose one of the following options:

— The main menu. You can use this option only if you are logged in as root.
If you have logged in as another user, you cannot use the main menu
links, even if you become root.

- On Red Hat, click System » IBM Installation Manager.
- On SUSE, click System Tools » IBM Installation Manager.

- Navigate to the eclipse subdirectory in the directory in which Installation
Manager is installed and run the command IBMIM.

— On the command line, start the Message Broker Toolkit uninstallation
wizard (where package_group_dir is the directory in which you have
installed the package group):

package_group_dir/uninstall/uninstall.sh
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For example:
/opt/IBM/WMBT610/uninstall/uninstall.sh

« WIIEN Choose one of the following options:

— Click Start » Programs » IBM Installation Manager » IBM Installation
Manager.

— Click Start » Settings > Control Panel > Add/Remove Programs. Open the
package group and select the package group in which you have installed
Message Broker Toolkit, for example IBM Software Development
Platform_1.

- Navigate to the eclipse subdirectory in the directory in which Installation
Manager is installed and run the command IBMIM.exe.

— On the command line, start the Message Broker Toolkit uninstallation
wizard (where package_group_dir is the directory in which you have
installed the package group):
package_group_dir\uninstall\uninstall.bat
For example:

C:\Program Files\IBM\WMBT610\uninstall\uninstall.bat

3. If you started Installation Manager from the Start or main menu, or by running
IBMIM or IBMIM.exe, click Uninstall Packages. The Uninstall Package panel
displays.

4. Select the Message Broker Toolkit and then click Next. The Uninstall Summary
panel is displayed.

5. Check that the items listed are those that you want to uninstall. Click Back if
you want to make changes, or click Uninstall to continue. The uninstallation
process starts.

6. Follow the guidance through the series of panels, providing input and
responses as required.

7. When the process completes, check the log file for errors. The file
YYYYMMDD_TIME.xml is written to the following directory:

. /var/ibm/InstallationManager/logs

« WIS %ALLUSERSPROFILE%\ Application Data\IBM\
InstallationManager\logs where %ALLUSERSPROFILE% is the environment
variable that defines the working directory. The default value is
C:\Documents and Settings\ All Users, but this value might be different in
your environment.

8. Restart your computer to complete the uninstallation of the Message Broker

Toolkit.

Uninstalling the Message Broker Toolkit in silent mode

Uninstall the Message Broker Toolkit without user interaction.

For information about alternative modes that are available, see ["How to install and]
[uninstall the Message Broker Toolkit” on page 51

Complete the following steps:
1. Log on to the computer on which Message Broker Toolkit is installed:

. Your user ID must have root authority. Follow your local security
guidelines to acquire root authority; either log in as root, or log in as another
user and become root.

« WIS Your user ID must have Administrator authority.
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2. To silently uninstall the Message Broker Toolkit, start IBM Installation Manager
using the supplied script files.

a. Navigate to the uninstall directory:

. package _group_dir/uninstall/
For example:
/opt/IBM/WMBT610/uninstall/

o W package_group dir\uninstall\
For example:
C:\Program Files\IBM\WMBT610\uninstall\
b. Open the following script file in a text editor:

. uninstall.sh

« WIS uninstall.bat
c. Modify the invocation of the IBMIM executable file as follows:
IBMIM -nosplash -input uninstall.xml -silent

3. Run the file that you just edited. The product is uninstalled silently; control is
returned to the command line when uninstallation is finished.

4. When the process completes, check the log file for errors. The file
YYYYMMDD_TIME.xml is written to the following directory:

. /var/ibm/InstallationManager/logs

« WM %ALLUSERSPROFILE%\ Application Data\IBM\
InstallationManager\logs where %ALLUSERSPROFILE% is the environment
variable that defines the working directory. The default value is
C:\Documents and Settings\ All Users, but this value might be different in
your environment.

5. Restart your computer to complete the uninstallation of the Message Broker
Toolkit

Uninstalling service from the Message Broker Toolkit
Remove maintenance or fixes from the Message Broker Toolkit.

To remove service from the Message Broker Toolkit on Linux (x86 platform), your
user ID must have root authority. Follow your local security guidelines to acquire
root authority; either log in as root, or log in as another user and become root. On
Windows, your user ID must have Administrator authority.

You can remove WebSphere Message Broker iFix and service updates from the
toolkit using IBM Installation Manager.

Complete the following steps:
1. Start Installation Manager in one of the following ways:
¢ From the Linux (x86 platform) main menu or the Windows Start menu:

— On Linux, you can use this option only if you are logged in as root. If you
have logged in as another user, you cannot use the main menu links, even
if you become root.

- On Red Hat, click System » IBM Installation Manager.
- On SUSE, click System Tools » IBM Installation Manager.

— On Windows, click Start > Programs » IBM Installation Manager » IBM
Installation Manager .
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* Navigate to the eclipse subdirectory in the directory in which Installation
Manager is installed and run the following command:

- IBMIM
— I IBMIM.exe

Installation Manager starts and displays its initial panel.

. Click Update Packages, then select the package group in which you have
installed the Message Broker Toolkit.

. Click Next. The Update Packages panel displays the products that you have

installed in the selected group. If you have applied updates to any item in the
list, they are displayed under the item to which they apply.

. If updates are installed, select the updates that you want to remove from each
particular installation and click Update. The fixes are removed from the
products that you have selected.
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Installation

Use the reference information in this section to understand your installation

options, and what effects your options have on the system.

+ [“Hardware requirements’]

+ [“Software requirements” on page 34|

+ ["Modes of installation and uninstallation” on page 47|

+ [“National language support” on page 53|

* [System changes|

Read the product readme.html file to see if additional options or restrictions are in
force; this file is provided on CD (or DVD) and installed with the product. You can

find the most up-to-date version on the Web, as described in [“Finding the latest|

[information” on page 4

Hardware requirements

This section provides information about the hardware requirements of WebSphere
Message Broker.

* [“Supported processors”|

+ ["Memory and disk space requirements” on page 32|

+ “Communications” on page 34|

Supported processors

WebSphere Message Broker is supported on multiple processors.

The requirements for each supported operating system are given in the following

table.

Operating system

Requirements’

AIX

IBM e(logo)server pSeries
IBM RS/6000° processor machines
IBM e(logo)server i5 (for AIX)

HP-UX (Integrity platform)

Hewlett-Packard Integrity servers

HP-UX (PA-RISC platform)

Hewlett-Packard HP-9000 PA-RISC 2.0 processor servers

Linux (POWER platform)

IBM e(logo)server iSeries” Server (using the IBM Integrated xSeries® Server

or Linux PowerPC®)
IBM e(logo)server pSeries
IBM RS/6000 processor servers

Linux (x86 platform)

IBM e(logo)server xSeries or equivalent Intel® based servers’

Linux (x86-64 platform)

Sun Microsystems AMD64, EM64T, or compatible processor servers’

Linux (zSeries platform)

IBM e(logo)server zSeries 600 or 700 Server

Solaris (SPARC platform)

Sun Microsystems SPARC processor servers

Solaris (x86-64 platform)

Sun Microsystems AMD64, EM64T, or compatible processor servers’

Windows

Windows x86 technology-compatible PC hardware®*

z/0S*

Any server capable of running one of the supported z/OS releases

Notes:

© Copyright IBM Corp. 2000, 2007
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. Always check the [WebSphere Message Broker Requirements| Web site

and the readme.html file for the latest information about supported
processors.

A readme file is supplied on the product DVD or CD (for runtime
components and for the Message Broker Toolkit), and you can access it
from the final panel of the relevant installation program. However, the
files are updated occasionally; access the [product readmes| Web page to
check that you have the latest level.

. The Message Broker Toolkit is supported on 32-bit systems only. It

requires an Intel Pentium® III (or higher) processor-based computer
with a processor speed of at least 700 MHz. This specification is the
minimum supported level; for improved performance use a 2 GHz

processor.

A minimum display resolution of at least 1024 x 768 is required for
some dialogs (for example, the Preferences dialog).

. The server must be capable of running a compatible supported

operating system, and have enough storage to meet the combined
requirements of the WebSphere Message Broker components that you
install, and all prerequisite products.

. See the Program Directory for WebSphere Message Broker for z/OS or the

Program Directory for WebSphere Message Broker with Rules and Formatter
for z/OS for further details.

Memory and disk space requirements

Check the memory and disk space that is required for your installation.

Requirements for memory and disk space depend on the installation operating
system, and on the WebSphere Message Broker components that you are installing.

Distributed systems
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* 512 MB of RAM is required to support runtime operations (1 MB equals

approximately 1000 000 bytes).

512 MB of RAM is required to support Message Broker Toolkit
operations on Linux (x86 platform) or Windows. This specification is the
minimum supported level; for improved performance, provide 1 GB (1
GB equals approximately 1 000 000 000 bytes).

Disk space requirements are dependent on the components that you
install and the working space that is required by those components (for
example, for WebSphere MQ queues and persistent messages).

Check that your computer has at least the space shown in the table
below, which provides guidance for both permanent product
requirements and temporary space. If you install just one or two of the
runtime components, the storage required is reduced by only a small
amount. Check that these requirements have not been updated in the
latest product readme file readme.html.

If the installation directory and the temporary space are on the same
partition or drive, add together the two figures to check that you have
enough space available. If you do not, increase the available storage or
change either the location of the temporary space or the installation
directory. The temporary files are deleted when installation has
completed.

- On AIX, HP-UX, and Linux systems, the default temporary space
directory is /tmp.


http://www.ibm.com/software/integration/wbimessagebroker/requirements/
http://www.ibm.com/support/docview.wss?uid=swg27006913

— On Solaris systems, the default temporary space directory is
/var/tmp.

— On Windows, the default temporary space directory is pointed to by
the TEMP system variable. On some systems, the variable TMP exists
and is used before TEMP, therefore you might need to check or
change the setting of both these variables.

The installation wizard displays requirements for permanent space, but
not for temporary space. If the figure that the installation wizard
displays is greater than the figure shown in the following tables, check
that your computer has sufficient space before you continue with the
installation.

Component

Linux POWER
platform)

Linux (x86
platform)’

Linux (x86-64
platform)

Linux (zSeries
platform)

Windows!

Broker, Configuration
Manager, and User
Name Server

440 MB plus 300
MB temporary
space

440 MB plus 300
MB temporary
space

600 MB plus 300
MB temporary
space

440 MB plus 300
MB temporary
space

460 MB plus 300
MB temporary
space

Message Broker Toolkit

Not available

1.52 GB plus 2.1
GB temporary
space

Not available

Not available

1.58 GB plus 2.1
GB temporary
space

Component

AIX

HP-UX
(Integrity
platform)

HP-UX
(PA-RISC
platform)

Solaris (SPARC
platform)

Solaris (x86-64
platform)

Broker, Configuration
Manager, and User
Name Server

840 MB plus 300
MB temporary
space

740 MB plus 300
MB temporary
space

800 MB plus 300
MB temporary
space

860 MB plus 300
MB temporary
space

540 MB plus 300
MB temporary
space

Message Broker Toolkit

Not available

Not available

Not available

Not available

Not available

Notes:

1. The maximum space shown for the Message Broker Toolkit
includes the space that is required for the shared resources
directory and the package group directory.

* If you install one of the database products supplied with WebSphere

Message Broker, you need additional disk space:

— DB2 Enterprise Server requires approximately 300 MB. This
specification is for a Compact installation, which provides sufficient
function for WebSphere Message Broker; if you choose a Typical or
Custom installation, additional storage might be required.

- On Windows, ODBC (Open Database Connectivity) drivers for the
Derby database require approximately 105 MB.

* On computers on which you create a broker, approximately 10 MB is
required for the broker tables. If you create user databases that are
accessed by message flows, additional space is required on those
computers.

* If you intend to create more than one broker on any one computer, you
will need additional memory and swap space. For example, you might
create more than one broker at different versions to complete migration.
Plan for 1 GB RAM and 1 GB of swap space for each broker, in addition
to the space and memory requirements of other applications.
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You might need to increase these figures if you deploy complex message
flows to the brokers, or if you process large messages (of many
megabytes) or complex messages that contain many different tags.

z/OS  See the section about DASD storage requirements in the Program Directory
for WebSphere Message Broker for z/OS or the Program Directory for WebSphere
Message Broker with Rules and Formatter for z/OS.

Communications

Your system must have communications hardware that supports at least one of the
following protocols:

* NetBIOS

* SNALU 6.2

* SPX

+ TCP/IP

Software requirements

View the operating system, database, and other software requirements.

This section provides information about requirements of WebSphere Message
Broker:

* [“Support for 32-bit and 64-bit platforms”|

+ [“Operating system requirements” on page 35|

+ [“Supported databases” on page 37|

+ |“Additional software requirements” on page 43|

+ [“Optional software support” on page 45|

Support for 32-bit and 64-bit platforms

WebSphere Message Broker operates in both 32-bit mode, or 64-bit mode, or both,
on supported operating systems.

On operating systems where both modes are supported, 64-bit operation is the
default mode. You cannot create execution groups for a broker in a mode that is
not supported by its underlying hardware and software.

If you are migrating from Version 6.0, broker operation and execution group
support has changed as indicated in the following table, and you might need to
make additional changes in your configuration. See [Migrating from Version 6.0|
[products| and [Configuring WebSphere Message Broker] for further details.

Broker core

components and | 32-bit execution |64-bit execution
Platform commands groups groups
Linux (x86 platform) 32-bit Yes No
Windows 32-bit Yes No
z/0OS 32-bit Yes No
AIX 64-bit Yes Yes
HP-UX (PA-RISC platform)’ 64-bit Yes Yes
Linux (x86-64 platform) 64-bit Yes Yes
Solaris (SPARC platform)! 64-bit Yes Yes
HP-UX (Integrity platform) 64-bit No Yes

34 Managing your Installation



Broker core
components and | 32-bit execution |64-bit execution
Platform commands groups groups
Linux (POWER platform)'** 64-bit No Yes
Linux (zSeries platform)'** 64-bit No Yes
Solaris (x86-64 platform)'* 64-bit No Yes
Notes:

1. On this operating system, the broker core components (bipservice,
bipbroker) operate in 64-bit mode; in Version 6.0, the broker core
components operated in 32-bit mode.

2. On this platform, you can no longer create or run with 32-bit execution
groups. Execution groups can be only 64-bit mode.

Execution groups

If you do not specify a size when you create an execution group on operating
systems on which both 32-bit and 64-bit modes are supported, a 64-bit execution
group is created. The following table defines what execution groups are created
when you use different methods (workbench, CMP API, or command) on different
operating systems.

32-bit 32-bit and | 64-bit
only 64-bit only
Workbenchh Command | CMP API platforms | platforms |platforms
Default no createExecutionGroup (name) 32-bit 64-bit 64-bit
options
32-bit -S createExecutionGroup (name, 32)32-bit 32-bit 64-bit!
64-bit -1 createExecutionGroup (name, 64)32-bit? 64-bit 64-bit
Notes:

1. BIP2828 is generated in this situation.
2. BIP2827 is generated in this situation.

Operating system requirements

WebSphere Message Broker is supported on multiple operating systems.

Operating system software requirements are defined in the following table.

Operating system

Requirements’

AIX

« IBM AIX Version 5.3 (Technology Level 4)®

HP-UX (Integrity platform)  HP-UX 11i V2 (B.11.23) for Integrity (with HP-UX

recommended patches for Java 5.0)
* HP-UX 11i V3 (B.11.31) for Integrity

HP-UX (PA-RISC platform) + HP-UX 11i V2 (B.11.23) (with HP-UX recommended

patches for Java 5.0)
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Operating system Requirements’

Linux (POWER platform) * Linux PowerPC Red Hat Enterprise Linux Advanced
Server V4.0 with service level Update 2

* Linux PowerPC Red Hat Enterprise Linux Advanced
Server V5.0

* Linux PowerPC SUSE Linux Enterprise Server (SLES)
9 RC5 or above

* Linux PowerPC SUSE Linux Enterprise Server (SLES)
10

Linux (x86 platform)’ * Linux Intel Red Hat Enterprise Linux Advanced Server
V4.0 with service level Update 2

* Linux Intel Red Hat Enterprise Linux Advanced Server
V5.0*

* Linux Intel SUSE Linux Enterprise Server (SLES) 9
¢ Linux Intel SUSE Linux Enterprise Server (SLES) 10*

Linux (x86-64 platform) * Linux Intel Red Hat Enterprise Linux Advanced Server
V4.0 with service level Update 2

* Linux Intel Red Hat Enterprise Linux Advanced Server
V5.0

* Linux Intel SUSE Linux Enterprise Server (SLES) 9
e Linux Intel SUSE Linux Enterprise Server (SLES) 10

Linux (zSeries platform) * Linux zSeries (64-bit) Red Hat Enterprise Linux

Advanced Server Version 4.0 with service level Update
2

* Linux zSeries (64-bit) Red Hat Enterprise Linux
Advanced Server Version 5.0

* Linux zSeries (64-bit) SUSE Linux Enterprise Server
(SLES) 9

* Linux zSeries (64-bit) SUSE Linux Enterprise Server
(SLES) 10

Solaris (SPARC  platform) * Sun Solaris Operating Environment 9 (with SunSolve
recommended Patch Cluster level)®

* Sun Solaris Operating Environment 10 (with SunSolve
recommended Patch Cluster level)

Solaris (x86-64 platform) * Sun Solaris Operating Environment 10 (with SunSolve

recommended Patch Cluster level)’

Windows’ + Microsoft® Windows XP Professional (with service
level SP2)
* Microsoft Windows Server 2003 Standard Edition

* Microsoft Windows Server 2003 Enterprise Edition

z/0S® e IBM z/0S Version 1.7 at RSU0609 or later (for the
target system) with PTFs for APARs PK34716 and
PK34041

e IBM SMP/E for z/OS Version 3.3 or later

Notes:

1. Always check the [WebSphere Message Broker Requirements| Web site
and the readme.html file for the latest information about supported
software.
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A readme file is supplied on the product DVD or CD (for runtime
components and for the Message Broker Toolkit), and you can access it
from the final panel of the relevant installation program. However, the
files are updated occasionally; access the [product readmes| Web page to
check that you have the latest level.

2. WebSphere Message Broker requires the xIC runtime libraries at Version
8 or above. If you do not have an xIC or xIC++ compiler at this version
installed, you must apply a PTF; information and instructions are
provided in this [support document]

3. On Linux (x86 platform) installations, you might require the following
additional packages that are available with the operating system:

* If you install in graphical mode on SUSE Linux Enterprise Server,
install package compat (at version 2002.12.6.0 or later). This package is
not required for console or silent installations.

* If you want to use the package manager (RPM), install package
rpm-build.
4. The Message Broker Toolkit is not supported on these operating system
versions.

5. If you install the broker or Configuration Manager on this operating
system version, the recommended Patch Cluster level must include
patches 111711-16 (32-bit) and 111712-16 (64-bit).

6. WebSphere Message Broker is supported only in the Global zone, or in
a whole root non-global zone, and must be installed separately in each.

7. Windows operating systems are supported in 32-bit mode only.
8. See the Program Directory for WebSphere Message Broker for z/OS or the
Program Directory for WebSphere Message Broker with Rules and Formatter

for z/OS for further details. In particular, review the information in
"Preventative Service Planning”.

Supported databases

A broker requires access to a database to store operational and state data.
Databases from IBM and other suppliers are supported.

You must create the broker database before you create the broker, and specify the
name of the database on the [mgsicreatebroker command| The command creates
tables to hold the broker data; these tables are listed in [“Database contents” on|
-ae 41.

Multiple brokers within a single instance can access the same database, if
appropriate, because the tables that are created are qualified by the broker name.
Brokers in different installation locations on the same system cannot share a
database.

The following table, and the accompanying notes, indicate the minimum levels of
database products that are supported on each operating system. Some data types
supported by these databases are not supported by WebSphere Message Broker; for
details see [Data types of values from external sources}

You can also configure message flows that access user databases. The support
provided is the same as for broker databases, shown in the table below.
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In most environments, the broker does not have to be running on the same
operating system as the database server. For details about local and remote
database use, and the restrictions that apply, see [“Database locations” on page 40

Database support is shown below; for the latest details on all supported platforms,

visit the [WebSphere Message Broker Requirements| Web site.
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Operating system |DB2' | Microsoft Oracle'? Sybase’ Informix®*
SQL Server'
AIX 8.2 2000 SP3a°  |9i Release 2 Patch Set 4 |12.5 Dynamic Server V9.4
9.1* 2005 SP1° (9.2.0.5, patch 3501955) with UC7 fix pack
10G Release 1 Client SDK V2.90
10G Release 2° with UC4 fix pack
HP-UX 8.2 Not 10G Release 2 Not Not supported
(Integrity platform) |9.1* applicable supported
HP-UX 8.2 Not 9i Release 2 Patch Set 4 |12.5 Dynamic Server V9.4
(PA-RISC platform) |9.1*7 |applicable (9.2.0.5, patch 3501955) with UC7 fix pack
Client SDK V2.90
10G Release 1 with HC4 fix pack
10G Release 2
Linux (POWER 8.2 Not 9i Release 2 Patch Set 4 |12.5 Dynamic Server V9.4
platform) 9.1* applicable (9.2.0.5, patch 3501955) with UC7 fix pack
Client SDK V2.90
10G Release 1 with UC4 fix pack
10G Release 2
Linux 8.2*% 2000 SP3a® |9i Release 2 Patch Set 4 |[12.5 Dynamic Server V9.4
(x86 platform) 9.1* 2005 SP1° (9.2.0.5, patch 3501955) with UC7 fix pack
Client SDK V2.90
10G Release 1 with UC3 fix pack
10G Release 2
Linux 8.2! Not 9i Release 2 Patch Set 4 |Not Dynamic Server V9.4
(zSeries platform) 9.1 applicable (9.2.0.5, patch 3501955) supported with UC7 fix pack
Client SDK V2.90
10G Release 1 with UC4 fix pack
10G Release 2
0S/400% 8.2 Not Not applicable Not Not applicable
applicable applicable
Solaris 8.241% 12000 SP3a’ 9i Release 2 Patch Set 4 |12.5 Dynamic Server V9.4
(SPARC platform) |9.1* 2005 SP1° (9.2.0.5, patch 3501955) with UC7 fix pack
Client SDK V2.90 with
10G Release 1 UC4 fix pack
10G Release 2
Solaris 82410 [ Not 10G Release 1 125 Not supported
(x86-64 platform) 9.1* applicable 10G Release 2
Windows 824! 12000 SP3a®  |9i Release 2 Patch Set 4 |12.5 Dynamic Server V9.4
9.1* 2005 SP1° (9.2.0.5, patch 3501955) with TC7 fix pack
10G Release 1 Client SDK V2.90
10G Release 2 with TC4 fix pack
z/08S 8.1%  [Not Not supported Not Not supported
9.1 |applicable applicable
Notes:
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. Supported releases of DB2, Informix, Oracle, and Sybase can
participate as a Resource Manager in a distributed XA transaction, and
can be coordinated by WebSphere MQ as the XA Transaction Manager.
On z/0S, all transactions are coordinated by Recoverable Resource
Services (RRS). In WebSphere Message Broker, this support is referred
to as globally-coordinated message flow support.

WebSphere MQ Version 6.0.1 or later is required for
globally-coordinated transaction support (XA).

If you use WebSphere MQ Version 6 as a transaction manager, all data
sources that are connected to DB2 from message flows in both 32-bit
and 64-bit execution groups must connect to 64-bit DB2 instances.

XA coordination for messages in the MRM domain on Windows
requires DB2 Version 8 FixPak 10 or later.

If you deploy message flows that access databases, you can define the
message flows to be coordinated so that updates to those databases are
synchronized with updates to other resources.

Supported connections to databases:

* ODBC drivers for Oracle and Sybase on all relevant systems, and for
SQL Server on Linux and UNIX systems, are supplied with
WebSphere Message Broker; alternative drivers are not supported on
these systems. For other systems and for other databases on all
systems, obtain these files from your database vendor.

* JDBC drivers are not supplied with WebSphere Message Broker;
obtain these files from your database vendor. The following JDBC
type 4 drivers are supported:

— IBM DB2 Driver for JDBC and SQLJ Version 9.1

Microsoft SQL Server 2005 JDBC driver 1.1 (non-XA only)

Oracle 10gR2 JDBC Driver

Sybase jConnect for JDBC 6.05

IBM Informix JDBC 3.00.JC3

JDBC type 4 transaction support using DB2 requires DB2 Version 9.1
FixPak 2 or later; support for DB2 Version 8 is not available.

. If you install the Oracle Database Server on 32-bit systems, or on
mixed mode systems on which you plan to create 32-bit execution
groups, you must also install the Oracle Runtime Client.

. Informix is supported only as a user database accessed by message
flows; you cannot create a broker database as an Informix database.

Each broker system requires only the client SDK; install the Dynamic
Server on the system on which you create databases.

Large Objects (LOBs) are not supported.

. Check the readme.html file for your product to check whether a fix
pack or other fix is required.

DB2 Version 8.2 is functionally equivalent to Version 8.1 FixPak 7.

If you connect to DB2 Version 8.2 with a broker that operates in 64-bit
mode, you must specify that you want to create a 64-bit database
instance. If you use DB2 Version 9.1, a 64-bit instance is the default
instance created on 64-bit operating systems.

. On Linux or UNIX systems, you can remotely access a SQL Server
database on Windows using a supplied wire protocol driver.

. On AIX, Oracle 10G Release 2 requires the AIX fix for APAR I'Y89080.
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10.

11.

12.

If you use DB2 V9.1 on HP-UX (PA-RISC platform), you must set the
following environment variable, and export it in the broker’s
environment:

MQSI_SIGNAL_EXCLUSIONS=10

If you have installed Red Hat Enterprise Linux AS V4.0 and DB2
Version 8 FixPak 9 on Linux (x86-64 platform), you must use a 32-bit
database instance. If you have a later release of DB2, you can use both
32-bit and 64-bit database instances.

You can configure message flows to access DB2 databases on OS/400
for user data. The message flows can run on any supported broker
platform. You cannot create a broker database on OS/400 as a remote
DB2 database from any broker platform. For further details of these
restrictions, and for information about the PTFs that are required with
this product, see [“Database locations.”|

Solaris 10 on Solaris (SPARC platform) requires DB2 Version 8 FixPak
9 or later; Solaris 10 on Solaris (x86-64 platform) requires DB2 Version
8 FixPak 11 or later.

You can use the embedded Derby database for verification, evaluation,
and test purposes only. (Derby refers to the database product based on
the Apache Derby open source project from the Apache Software
Foundation.) For a production system, install and configure your
chosen enterprise database.

On z/0S, DB2 is a mandatory requirement. You must create a unique
database for each broker. See the Program Directory for WebSphere
Message Broker for z/OS or the Program Directory for WebSphere Message
Broker for z/OS for further details.

Database locations
The broker can access databases set up on the local computer, or on a remote

server.

A broker domain requires databases to support its brokers. (The Configuration
Manager and the User Name Server have no requirement for database access.) In
addition, your brokers can host message flows that access user databases.

You can choose to create and configure these databases on the local broker system,
or on a remote system, subject to the following restrictions:

* You can use a local or remote database for the broker tables, with the exception
that a remote database cannot be accessed on z/OS or OS/400.

* You can use a local or remote database for user data, subject to the following
operating system restrictions:

Database on OS/400
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Database support on iSeries (OS/400) is DB2 only.

You must have installed OS/400 Version 5.2, Version 5.3, or Version
5.4 on the iSeries server.

On Linux, UNIX, and Windows you can connect using DB2 Connect™.
On Windows only you can also use iSeries Access for Windows.

Globally-coordinated (XA) transactions are not supported.

Message flows that include Rules and Formatter Extension nodes
cannot access a database on OS/400.

You can call stored procedures only if access to the remote database is
provided by DB2 Connect.



Database on z/OS
— Database support on z/0S is DB2 only.
— You must use DB2 Connect on Linux, UNIX, and Windows.

— Message flows that include Rules and Formatter Extension nodes
cannot access a database on z/OS.

For further details, see the Program Directory for WebSphere Message Broker
for z/OS or the Program Directory for WebSphere Message Broker with Rules
and Formatter for z/OS.

WebSphere Information Integrator Support

— Message flows on all distributed systems brokers can access data
sources on WebSphere Information Integrator for Linux, UNIX, and
Windows Version 8.2.

Message flows on distributed systems can also access data sources on
WebSphere Information Integrator Classic Federation for z/OS
Version 8.2, on broker platforms for which WebSphere Information
Integrator Classic Federation client code is provided.

— Message flows on z/OS brokers can access WebSphere Information
Integrator Classic Federation for z/OS Version 8.2. This support
provides direct SQL connectivity with the following z/OS data
sources:

- IMS™

- VSAM

- ISAM

- Sequential files

- CA-IDMS

- CA-Datacom

- Software AG ADABAS
- DB2

WebSphere Information Integrator Classic Federation for z/OS
Version 8.2 is supported only with a CAF (Call Attachment Facility)
ODBC connection. This support does not include two phase commit,
and database operations are not coordinated by RRS.

* If you choose to use a remote database, you must configure the ODBC
connection to the database correctly. Refer to the documentation for the database
product that you are using for further information.

See the documentation for your database product using for WebSphere Message
Broker to determine the best options for your specific environment and
requirements, and information about how to configure remote databases access.

Database contents

WebSphere Message Broker stores configuration and resource information in
databases to retain the information and ensure its security and integrity. Each
broker creates and maintains information in tables specifically created for that
purpose.

When you create a broker, the mgsicreatebroker command creates a number of
database tables within the database that you specify in the command. You can
specify a different database for every broker, or share a database between brokers.
The database tables schema inherits its name from the Data Source User ID
specified in the create command.
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The table below shows the database tables that are created by the mgsicreatebroker
command in the broker database. The tables are created when you create the first
broker. When you create further brokers specifying the same database, new rows
are created for each broker. Every row created in the table includes the broker
name, therefore each row is unique to a single broker.

Table name Description

BACLENTRIES ACL entries

BCLIENTUSER Maps client identifiers to durable subscriptions

BGROUPNAME Publish/subscribe principals: groups

BMQEPUBDEST Contains list of WebSphere MQ Everyplace® queues on which messages can
be placed

BMQEPUBMSGIN Holds persistent WebSphere MQ Everyplace publish/subscribe messages
waiting to be processed by the broker

BMQEPUBMSGOUT Holds persistent WebSphere MQ Everyplace publish/subscribe to be placed
on an WebSphere MQ Everyplace queue

BMQESTDMSGIN Holds persistent WebSphere MQ Everyplace non-publish/subscribe
messages waiting to be processed by the broker

BMQESTDMSGOUT Holds persistent messages to be sent to WebSphere MQ Everyplace
destinations

BMQPSTOPOLOGY Publish/subscribe neighbor information

BMULTICASTTOPICS Multicast topics records

BNBRCONNECTIONS Inter-broker neighbor connection information

BPUBLISHERS Registered publishers

BRETAINEDPUBS Retained publications

BRMINFO Registered resource managers

BRMPHYSICALRES Physical resources

BRMRTDDEPINFO Runtime dictionary dependency values

BRMRTDINFO Registered runtime dictionaries

BRMWEFDINFO Registered wire format descriptors

BROKERAA Broker process details to support recovery

BROKERAAEG Execution group details to support recovery

BROKERRESOURCES Broker resources

BSCADADEST Contains list of SCADA clients to which messages can be sent

BSCADAMSGIN Holds persistent SCADA messages waiting to be processed by the broker

BSCADAMSGOUT Holds persistent messages to be sent to SCADA destinations

BSUBSCRIPTIONS Durable subscription information

BTOPOLOGY Inter-broker neighbor information

BUSERCONTEXT Maps client identifiers to context information

BUSERMEMBERSHIP Publish/subscribe principals: membership

BUSERNAME Publish/subscribe principals: users
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Additional software requirements

WebSphere Message Broker requires additional software products to run
successfully:

* [“WebSphere MQ”|

+ [ava runtime environment]

+ |“Installation Manager” on page 44

* XML Toolkit” on page 45|

* [“Browsers” on page 45|

WebSphere MQ

WebSphere MQ is required for all WebSphere Message Broker components at the
minimum supported level shown in the table below.

WebSphere MQ Version 6.0 (with tailored terms and conditions for use with
WebSphere Message Broker) is supplied on DVD (on Linux (x86 platform) and
Windows only) and on CD. If you have a previous version of WebSphere MQ, you
can use the supplied CDs or DVD to upgrade your current installation.

Operating system

Requirements

AIX

HP-UX (Integrity platform)
HP-UX (PA-RISC platform)
Linux (POWER platform)
Linux (x86 platform)®
Linux (zSeries platform)
Solaris (SPARC platform)

Solaris
(x86-64 platform)

Windows®

WebSphere MQ Version 6.0 (or later)' ™"

z/0S*

WebSphere MQ Version 6.0.0 (or later)
with MQ Java Classes feature®

Notes:

. The minimum set of components that you must install are the server

and Java Messaging components. You can install WebSphere MQ before
or after you install WebSphere Message Broker.

If you have WebSphere MQ Version 6.0 already installed, the Java
Messaging component is not installed by default. Check that your
installation includes it; add this component from the WebSphere MQ
Version 6.0 CD if it is not installed.

On Windows, if you choose to install WebSphere MQ Version 6.0 from
the Windows Launchpad, Express installation installs all required
components for you. If you use Advanced installation, you must select a
custom installation and include the server and Java Messaging
components.
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If you start the WebSphere MQ Version 6.0 installation program directly
on any platform, including Windows, you must select a custom
installation and include the server and Java Messaging components.

If you want to use the WebSphere MQ Explorer, the graphical interface
that is available on Linux (x86 platform) and Windows only, install the
WebSphere Eclipse Platform Version 3.0.1 and the WebSphere MQ
Explorer components.

Other components are optional for use with WebSphere Message Broker.

2. Check the availability of WebSphere MQ Version 6.0 on your operating
system; exact GA versions vary on different platforms.

3. For some specific broker functions, later levels of WebSphere MQ might
be required:

* Globally-coordinated (XA) transactions are supported only by
WebSphere MQ V6.0.1.0 or later.

* If you develop message flows that use WebSphere MQ Real-time
Transport with Multicast PGM support, you must install an iFix on
WebSphere MQ Version 6.0; see the readme.htm] file for the latest
information.

4. WebSphere MQ is not required on systems on which you install only
the Message Broker Toolkit.

5. On z/0OS, WebSphere MQ is a mandatory requirement and must be
installed before you install WebSphere Message Broker. See the Program
Directory for WebSphere Message Broker for z/OS or the Program Directory
for WebSphere Message Broker with Rules and Formatter for z/OS for further
details about required levels of WebSphere MQ.

For details of WebSphere MQ products and supported versions, see the [WebSphere

[[ntegration products system requirements| Web site.

JRE

A Java" runtime environment (JRE) is required on all platforms:

e On distributed platforms, Java Runtime Environment (JRE) Version 5 SR5 is
embedded in product components.

* On z/0S, you must acquire and install a JRE which must be at Version 5 SR5 or
later.

See the Program Directory for WebSphere Message Broker for z/OS or the Program
Directory for WebSphere Message Broker with Rules and Formatter for z/OS for
further details and the latest information. In particular, review the information in
"Preventative Service Planning”.

WebSphere Message Broker supports any JMS 1.1 provider. You must consider both
this level of support and the supported JRE when you select a JMS provider whose
client will be embedded in the broker.

Installation Manager
The IBM Installation Manager is required to install Message Broker Toolkit and
other Rational® products, and controls installation, management, updates, licensing,

and uninstall.

For further information about Installation Manager and the Message Broker
Toolkit, see the |[“Installation Guide” on page 3
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XML Toolkit
For z/0OS only, you must install the IBM XML Toolkit for z/OS, Version 1.9.

See the Program Directory for WebSphere Message Broker for z/OS or the Program
Directory for WebSphere Message Broker with Rules and Formatter for z/OS for further
details and the latest information. In particular, review the information in
"Preventative Service Planning”.

Browsers

For best results when viewing the information center from the Message Broker
Toolkit, use Internet Explorer Version 6.0 (or later) on Windows, or Mozilla 1.4.2
(or later) on Linux (x86 platform).

Some Linux (x86 platform) offerings do not install Mozilla by default. If you plan
to install the Message Broker Toolkit on your Linux (x86 platform) system, check
that a supported version of Mozilla is already installed. If not, install Mozilla from
your Linux (x86 platform) operating system media.

Optional software support

The products listed here are not required, but might be useful. Except where
stated, these products are not supplied with WebSphere Message Broker.

+ |“EIS client libraries”]

+ [“WebSphere MQ Everyplace”]|

* [“Tivoli License Manager”]

* [“Security providers” on page 46|

* [JMS providers” on page 46|

+ ["Compilers” on page 46|

* |“Adobe Flash Player” on page 47|

EIS client libraries

If you plan to use WebSphere Adapters on any supported operating system, you
must obtain the appropriate Enterprise Information System (EIS) client libraries
from the relevant EIS vendor (for example, PeopleSoft, Siebel, or SAP). The client
libraries are required to complete connections between Adapters nodes and the
EIS; install them on each computer on which you run a broker that hosts message
flows that include Adapters nodes.

WebSphere MQ Everyplace

WebSphere MQ Everyplace supports messaging to, from, and between pervasive
devices, including handheld devices such as mobile phones and PDAs.

WebSphere MQ Everyplace Version 2.0.2.0 is supplied with WebSphere Message
Broker.

Tivoli License Manager

To monitor the use of software products including WebSphere Message Broker,
install IBM Tivoli License Manager Version 2.1.
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Security providers

The runtime security manager interacts with external security providers:

* Lightweight Directory Access Protocol (LDAP) provides authentication and
authorization services.

* Tivoli Federated Identity Manager (TFIM) provides authentication, mapping, and
authorization services.

JMS providers

The JMSInput and JMSOutput nodes are compatible with, and work with, any JMS
provider that conforms to the JJava Message Service Specification, version 1.1|

Compilers

If you develop user-defined extensions in C/C++ or Java, you need the
appropriate supported software:

AIX
IBM XL C/C++ for AIX Version 8.0

HP-UX (PA-RISC platform)
HP aC++ Version A 03.73 or later

BNZT8N HP-UX (Integrity platform)
HP aC++ Version A 06.12 or later

Linux (POWER platform)
GNU g++, Version 3.3 or later

Linux (x86 platform)
GNU g++, Version 3.3 or later

Linux (zSeries platform)
GNU g++, Version 3.3 or later

IEIEIEM Solaris (SPARC platform)
Sun Studio 11

INEIEIEM Solaris (x86-64 platform)
Sun Studio 11

NI Windows
Microsoft Visual C++ .NET 2003

If you are using Microsoft Visual Studio 2005, you need to package
and ship the relevant Microsoft C Run Time (CRT) libraries
including the appropriate Microsoft manifest files together with
your .manifest files and your .dll files.

See the Microsoft Visual Studio documentation for details on
redistribution of the CRT.

z/0S
IBM z/0S C/C++, for z/OS Version 1.5 or later

Java  Version 5 (also known as Java 1.5) SR5 is supported on all operating
systems. An SDK is included on distributed systems, and is installed in the
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install_dir\jrel5 directory for Version 5 SR5. On z/0OS, you must install
your required level of JRE. For further details, see [“Additional software]
[requirements” on page 43

Adobe Flash Player

If you want to launch the Quick Tour from the information center in the Message
Broker Toolkit, you must install Adobe Flash Player Version 6.0 or later. You can
freely download from the [Adobe Web site]an Adobe Flash Player plug-in for the
Web browsers that are supported by the Message Broker Toolkit.

Modes of installation and uninstallation

You can specify different modes for installation and uninstallation of runtime
components and the Message Broker Toolkit.

When you install or uninstall the runtime components, you can choose graphical,
console, or silent mode. These options are described in [“How to install and|
[uninstall runtime components.”|

When you install or uninstall the Message Broker Toolkit, you can choose graphical
or silent mode. These options are described in [“How to install and uninstall the|
[Message Broker Toolkit” on page 51)

Examples of commands in the topics in this section use installer and uninstaller for
the names of the installation or uninstall wizard. Substitute the correct names for
the platform on which you are using the wizard. Unless otherwise specified, you
can use the examples for uninstalling components, or applying service; the same
format is used for all three operations.

How to install and uninstall runtime components

You can install and uninstall runtime components in three ways.

The following modes are supported:
* [“Graphical mode”]

+ [“Console mode” on page 48|

+ [“Silent mode” on page 48|

Each mode has different advantages, which are discussed in the appropriate
sections. When you have chosen the mode that you want to use, follow the
installation instructions in the [“Installation Guide” on page 3| or in[“Uninstalling”|

Graphical mode

The installation and uninstallation wizards start in graphical mode if you start
them with no options (the default mode). The wizards guide you through the
installation or uninstallation process with a series of pages that present options and
defaults. You can accept the default values, or change them to suit your
environment and requirements.

Graphical mode provides the highest level of information and guidance to help
you complete installation or uninstallation. Use this mode when you are unfamiliar
with the product, or if you want to monitor the installation or uninstallation
progress.
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If you click Cancel before the Install Progress or Uninstall Progress panel appears,
you can exit the setup. If you choose to exit, your system returns to its state that it
was in before the wizard was launched. However, if you cancel the installation
wizard after installation or uninstallation has completed, and the final summary
panel is displayed, your system is not restored to its previous state: the wizard
stops immediately. If you want to remove any program that has been installed,
invoke the uninstallation wizard.

When you use the wizards, you might have to wait a few seconds to move to the
next panel after clicking Next. Progress is not always displayed on all panels. If
you click Next twice, you might skip an entire panel. To ensure the installer or
uninstaller is progressing, you can monitor your CPU usage, which increases
greatly during both installation and uninstallation.

Console mode

Console mode presents a character-based interface with which you interact in a
command window. It presents the same options as the graphical interface.

Use console mode if you want a command-line interface rather than a graphical
interface. This interface is also suitable for users who use only the keyboard to
choose values and navigate through installation, and those with screen reader
software such as JAWS.

Invoke the installer using the following command. Use the same format for the
uninstaller.

installer -console

Use these prompts to navigate through the wizard:
* 1 Move to the next panel

e 2 Return to the previous panel

* 3 Cancel and terminate the wizard

* 4 Redisplay the current screen

The default option is always displayed within brackets, for example [1]. If this
default value is the correct choice, press Enter to continue.

Silent mode

If you use silent mode to uninstall runtime components, the wizard always
uninstalls components from the last known Version 6.1 installation location (that is,
the most recent installation), regardless of the location of the uninstallation wizard
that you invoke. If you want to remove components from an earlier Version 6.1
installation, use console or graphical mode.

If you start a silent installation or uninstallation, the wizard runs without any
interaction. In this mode, the process is completed with default options, or

according to a predefined set of options.

Use silent mode with unattended interface for automated installation or
uninstallation over a large number of identical systems.

Silent mode does not provide any feedback to the caller, therefore you must view
the log to check whether the action was successful.
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You can perform a silent installation in the following ways:
* With default options:

The installation wizard performs the following actions:
— Checks that prerequisite software is installed

— Installs to the default directory

— Installs all selectable features

Because the installation wizard checks for prerequisite software in silent mode,
the program fails if the prerequisite software is not already installed. You can
override this check if you use a response file (see [“Using response files with|
[runtime components”), or include the appropriate parameter with a non-default
value on the command invocation.

The uninstallation wizard performs the following actions:
— Removes all selectable features

To run the wizard with default options, specify the -silent option on the
command:

installer -silent
* With one or more non-default options:

If you want the wizard to use non-default values for one or more options, you
can specify either non-default options on the command invocation, or a response
file, as described in [“Using response files with runtime components.”|

A sample response file is provided in the sample-scripts directory of the root CD
directory. This file includes detailed information about the options that you can
change, and the values that you must enter to change them. Tailor this file to
match your requirements, or generate a new response file.

To run a tailored silent installation using a response file called responsel.txt,
specify the -silent option and the file name on the command:

installer -silent -options responsel.txt

Using response files with runtime components
Specify a response file to define the behavior of the installation or uninstallation
wizard.

You can use response files to install or uninstall runtime components, or to apply
service updates.

+ |“Editing the sample response files”|

+ [“Recording a response file” on page 50|

* |“Generating response files” on page 50|

+ |“Calling response files in commands” on page 51

If you want to install or uninstall in silent mode, but you want to use options with
non-default values, you can supply a response file to the wizard. A response file is
a text file that contains options that define the choices that the wizard makes.

Editing the sample response files:

Sample response files are supplied. On Linux and UNIX systems, the files are
/sample-scripts/install.opt and /sample-scripts/uninstall.opt. On Windows, the
files are \sample-scripts\install.opt and \sample-scripts\uninstall.opt. The sample
response files include detailed information about the options that you can change,
and the values that you can enter to change them. You can tailor these files to
match your requirements.
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For example, you can modify the installation response file to take one or more of
the following actions:

* You must update the following line to remove the comment character at the start
of the line. If you do not do this, your other options are ignored.

# -W setupTypes.selectedSetypTypeld=
Remove the number sign (the character #):
-W setupTypes.selectedSetypTypeld=
¢ Choose a custom installation (typical is the default option):
-W setupTypes.selectedSetupTypeld=custom
* Install to a non-default directory.

Find the following line, remove the number signs, and insert your chosen
installation directory:

### -P installlocation=<value>
* Choose which components to install.

For example, to exclude the Configuration Manager, find this line in the
response file:

# -P configManagerFeature.active=true
Change the line to read:
-P configManagerFeature.active=false
* Specify whether the program is to check for prerequisite software.

Add one or both of the following lines to the file to instruct the installation
wizard to ignore the check for specific software:

# don't check for WebSphere MQ -P mgPrerequisite.active=false
# don't check for Java Messaging -P javaMessagingPrerequisite.active=false

Recording a response file:

Use the following command to record a response file:
installer -options-record responsefile

where responsefile is the full path and name of your chosen response file. On
Windows, surround the path and name with double quotes if it contains spaces.
Create this file in a directory different to the one in which the product is installed.

The installation wizard starts in graphical mode, and requires your input as it
progresses. Your responses are recorded during installation. When installation is
complete, the response file contains all the choices that you have made during
installation.

If you want to record a response file during a console mode installation, use the
following command:

installer -options-record responsefile -console
Generating response files:

Use the following command to generate a template installation response file. The
wizard does not perform installation or uninstallation in this mode.

installer -options-template responsefile
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where responsefile is the full path and name of your chosen response file. On
Windows, surround the path and name with double quotes if it contains spaces. If
you are uninstalling, create the response file in another directory to ensure that it is
not deleted as part of the uninstallation.

The generated template response file contains full instructions on how to edit it to
specify your required options.

If you want to generate a response file during a console mode installation, use the
following command:

installer -options-template responsefile -console
Calling response files in commands:

Use the following command to run a wizard in silent mode with a response file:
installer -options responsefile -silent

where responsefile is the full path and name of your chosen response file. On
Windows, surround the path and name with double quotes if it contains spaces.

The wizard runs without interaction according to the options that are found in the
response file.

How to install and uninstall the Message Broker Toolkit

You can install and uninstall the Message Broker Toolkit in two ways.

The following modes are supported:
* [“Graphical mode”]
+ |“Silent mode” on page 52|

Each mode has different advantages, which are discussed in the appropriate
sections. When you have chosen the mode that you want to use, follow the
installation instructions in the [“Installation Guide” on page 3| or in[“Uninstalling”|

Graphical mode

The installation and uninstallation wizards start in graphical mode if you start
them with no options (the default mode). The wizards guide you through the
installation or uninstallation process with a series of pages that present options and
defaults. You can accept the default values, or change them to suit your
environment and requirements.

Graphical mode provides the highest level of information and guidance to help
you complete installation or uninstallation. Use this mode when you are unfamiliar
with the product, or if you want to monitor the installation or uninstallation
progress.

If you click Cancel before the Install Progress or Uninstall Progress panel appears,
you can exit the setup. If you choose to exit, your system returns to its state that it
was in before the wizard was launched. However, if you cancel the installation
wizard after installation or uninstallation has completed, and the final summary
panel is displayed, your system is not restored to its previous state: the wizard
stops immediately. If you want to remove any program that has been installed,
invoke the uninstallation wizard.
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When you use the wizards, you might have to wait a few seconds to move to the
next panel after clicking Next. Progress is not always displayed on all panels. If
you click Next twice, you might skip an entire panel. To ensure the installer or
uninstaller is progressing, you can monitor your CPU usage, which increases
greatly during both installation and uninstallation.

Silent mode

Use silent mode with unattended interface for automated installations over a large
number of identical systems.

Silent mode does not provide any feedback to the caller; therefore, you must check
the log to determine whether the installation or uninstallation was successful.

You can run a silent installation with default settings, or with one or more
non-default values:

* With default settings, the installation wizard performs the following actions:
— Installs to the default directories
— Installs all supported locales

To run a default silent installation, enter the following command. If Installation
Manager is not already installed, it is installed before the Message Broker Toolkit
is installed.

Linux (x86 platform)

./install -nosplash --Tauncher.suppressErrors -silent -input mbtoolkit-silent.xml

NN Windows
install.exe -nosplash --Tlauncher.suppressErrors -silent -input mbtoolkit-silent.xml

* With one or more non-default settings, the wizard applies the options that you
specify in a response file to determine what actions to take.

If you want the wizard to use non-default values for one or more options, you
can specify a recorded response file, as described in [“Using response files with|
[the Message Broker Toolkit.”]

Using response files with the Message Broker Toolkit
Specify a response file to define the behavior of the installation or uninstallation
wizard.

You can use response files to install or uninstall the Message Broker Toolkit, or to
apply service updates.

+ |“Editing the sample response files”|

* [“Recording a response file” on page 53|

+ |“Calling response files in commands” on page 53|

Editing the sample response files:

A sample response file mbtoolkit-silent.xml is supplied on Linux (x86 platform)
and Windows. The files assume that Installation Manager has not yet been
installed, and sets options to install both Installation Manager and the Message
Broker Toolkit in the default locations.

Although you can tailor these files to match your requirements, for example by
changing the installation locations, the record option on a graphical installation or
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uninstallation is preferable. If you use the record option, you do not have to
modify the file content, which is complex because the files handle multiple
installations, directories, and options.

Recording a response file:

Use the following command to record a response file:
* On Linux (x86 platform):

./install -record response.xml
* On Windows:

install.exe -record response.xml

where response.xml is the full path and name of your chosen response file. On
Windows, surround the path and name with double quotes if it contains spaces.
Create this file in a directory different to the one in which the product is installed.

The installation wizard starts in graphical mode, and requires your input as it
progresses. Your responses are recorded during installation. When installation is
complete, the response file contains all the choices that you have made during
installation.

Calling response files in commands:

Use the following command to run the installation wizard in silent mode with a
recorded response file:

* On Linux (x86 platform):

./install -nosplash --Tauncher.suppressErrors -silent -input response.xml
* On Windows:

install.exe -nosplash --Tauncher.suppressErrors -silent -input response.xml

where response.xml is the full path and name of the response file you recorded. On
Windows, surround the path and name with double quotes if it contains spaces.

The wizard runs without interaction, following the options that are found in the
response file.

National language support

The user interface and message catalogs are provided in the following languages
on distributed systems:
* Brazilian Portuguese
* French

* German

e Italian

* Japanese

¢ Korean

* Simplified Chinese

¢ Spanish

¢ Traditional Chinese
* US English

The message catalogs are provided in the following languages on z/OS:
* Japanese

 Simplified Chinese
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* US English

The messages written to the z/OS operator console (which are a subset of the
messages written to the syslog) are in US English only, and are written in mixed
case or in uppercase depending on your chosen system configuration.

WebSphere Message Broker provides a selection of message catalogs that are used
by the product components to report any problems that occur. Products that are
used in conjunction with WebSphere Message Broker might cause WebSphere
Message Broker to report errors using its message catalogs, or might report
problems using their own techniques.

You must refer to the documentation supplied with any other products that you
use to determine the process they employ. In particular, you must check the
documentation supplied by the databases that you use and documentation
provided with any user-defined node or parser that you integrate into the
WebSphere Message Broker environment.

You can install WebSphere Message Broker and WebSphere MQ in any supported
language; all language versions for each product are compatible with all language
versions for the other product. All languages for the WebSphere MQ messaging
products are included on the WebSphere MQ server CD supplied with WebSphere
Message Broker.

All messages generated for internal inter-component message exchange (for
example, deployed configuration messages and log files for mqsireadlog) are
generated in code page 1208 (utf-8).

Locales

Message support is provided in a number of locales.

Windows

English (United
States)

German (Standard)
Spanish (Modern
Sort)

French (Standard)
Italian (Standard)
Portuguese (Brazilian)

Japanese

Simplified Chinese
(China)

Traditional Chinese
(Taiwan)

WebSphere Message Broker supports at least the following locales:

AIX Solaris HP-UX! Linux? z/0S

en_US en_US en_US.is088591, en_US En_US.IBM-1047,
en_US.roman8 En_US.IBM-037

de_DE, De_DE de de_DE.ISO88591, de_DE not supported
de_DE.roman8

es_ES, Es_ES es es_ES.ISO88591, es_ES not supported
es_ES.roman8

fr FR, Fr_FR fr fr_ FR.ISO88591, fr_FR not supported
fr_ FR.roman8

it IT, It_IT it it_IT.ISO88591, it_IT not supported
it_IT.roman8

pt_BR, Pt_BR pt_BR pt_BR.ISO88591, pt_BR not supported
pt_BR.utf8

Ja_JP, ja_JP ja_JP.PCK, ja ja_JP.SJIS, ja_JP Ja_JP.IBM-939,
ja_JPeuc]P Ja_JP.IBM-930

Zh_CN, zh_CN  zh, zh.GBK zh_CN.hp15CN  zh_CN Zh_CN.IBM-

1388,
Zh_CN.IBM-935
Zh_TW, zh_.TW  zh_TW, zh_TW.big5, zh_ TW not supported
zh_TW.BIG5 zh_TW.eucTW
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Windows

Korean

AIX Solaris HP-UX' Linux’ z/0S
ko_KR ko ko_KR.eucKR ko_KR not supported

Notes:

1. These values are the same for HP-UX (Integrity platform) and HP-UX
(PA-RISC platform). Due to limited syslog support on HP-UX operating
systems, messages are written to the log in US English only.

2. These values are the same for Linux (POWER platform), Linux
(x86 platform), Linux (x86-64 platform), and Linux (zSeries platform).

Other locales might be supported; check your operating system for further details.

System changes caused by installation and configuration

When you install WebSphere Message Broker, the installation program causes
certain changes to be made to your system. Resources are also affected by how you
configure your system (for example, the brokers that you create).

+ [Directory structures|

+ [Registry contents]

+ [Environment variables|

+ [Default WebSphere MQ resources|

+ [Database contents|

Directory structures after installation

When you install WebSphere Message Broker, the installation program creates a
structure of subdirectories under the directory that you specified as the installation
directory. The exact structure depends on the platform on which you have installed
WebSphere Message Broker, and the components that you have installed.

If you install the Message Broker Toolkit, other directories might be created for
Installation Manager, the Shared Resources Directory, and the package group in
which you install the toolkit.

AIX, HP-UX (PA-RISC platform), Linux (x86-64 platform), and
Solaris (SPARC platform)

On AIX, HP-UX (PA-RISC platform), Linux (x86 platform, 64-bit), and Solaris
(SPARC platform), the default home directory install_dir is /opt/IBM/mgqsi/6.1.
The directories created in install_dir are shown in the following table.

Directories under install_dir | Contents

_uninst_runtime Uninstall programs

_uninst_runtime_jvm Uninstall programs (JVM)

adapters WebSphere Adapters files

bin Executable binaries

catalina Web Services support files

classes Java class files

DD64 ODBC driver and related files (64-bit support)
docs Java API files
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Directories under install_dir | Contents

exmltConfig XML transformation files

include Header and other files for samples

itlm Tivoli License Manager files

jplugin Java plug-in files

jrel5 IBM Runtime Environment for the Java Platform Version 5
(also known as Version 1.5)

lib Shared library files

license License files

lil Loadable library files (64-bit)

1il32 Loadable library files (32-bit)

merant ODBC driver and related files

messages Description files for messages and exceptions

migration Migration files

ODBC32 Sample 32-bit ODBC configuration files

ODBC64 Sample 64-bit ODBC configuration files

readmes Product readme files

sample C, C++, and Java sample files

SecurityProviders Security files (64-bit)

SecurityProviders32 Security files (32-bit)

webservices Web Services files

xIxpc Product library files

xml4c XML processing files

On AIX, HP-UX (PA-RISC platform), Linux (x86 platform, 64-bit), and Solaris
(SPARC platform), the default work directory is /var/mqsi/. The directories
created are shown in the following table.

Directories under /var/mgqsi

Contents

common/errors Error files
common/locks Resource locks
common/log Trace files
common/profiles User profiles
components Component details
odbc ODBC files

registry Registry information

shared-classes

User installed user-defined node classes

XML

XML files

XSL

XSL style sheets
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HP-UX (Integrity platform), Linux (POWER platform), Linux
(zSeries platform), and Solaris (x86-64 platform)

On HP-UX (Integrity platform), Linux (POWER platform), Linux (zSeries platform),
and Solaris (x86-64 platform), the default home directory install_dir is
/opt/IBM/mgqsi/6.1. The directories created in install_dir are shown in the

following table.

Directories under install_dir | Contents

_uninst_runtime Uninstall programs

_uninst_runtime_jvm Uninstall programs (JVM)

adapters WebSphere Adapters files

bin Executable binaries

catalina Web Services support files

classes Java class files

DDé64 ODBC driver and related files (64-bit support)

docs Java API files

exmltConfig XML transformation files

include Header and other files for samples

itlm Tivoli License Manager files

jplugin Java plug-in files

jrel5 IBM Runtime Environment for the Java Platform Version 5
(also known as Version 1.5)

lib Shared library files

license License files

lil Loadable library files

messages Description files for messages and exceptions

migration Migration files

ODBC64 Sample 64-bit ODBC configuration files

readmes Product readme files

sample C, C++, and Java sample files

SecurityProviders Security files

webservices Web Services files

xIxpc Product library files

xml4c XML processing files

On HP-UX (Integrity platform), Linux (POWER platform), Linux (zSeries platform),
and Solaris (x86-64 platform), the default work directory is /var/mgsi/. The
directories created are shown in the following table.

Directories under /var/mgqsi

Contents

common/ errors Error files
common/locks Resource locks
common/log Trace files
common/profiles User profiles
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Directories under /var/mgqsi

Contents

components Component details
config Profiles

odbc ODBC files

registry Registry information

shared-classes

User installed user-defined node classes

XML

XML files

XSL

XSL style sheets

Linux (x86 platform)

On this platform, you can install both the runtime components and the Message

Broker Toolkit.

Runtime components

On Linux (x86 platform), the default home directory install_dir is
/opt/ibm/mgqsi/6.1. The directories created in install_dir are shown in the

following table.

Directories under install_dir | Contents

_uninst_runtime Uninstall programs

_uninst_runtime_jvm Uninstall programs (JVM)

adapters WebSphere Adapters files

bin Executable binaries

catalina Web Services support files

classes Java class files

docs Java API files

exmltConfig XML transformation files

include Header and other files for samples

itlm Tivoli License Manager files

jplugin Java plug-in files

jrel5 IBM Runtime Environment for the Java Platform Version 5
(also known as Version 1.5)

lib Shared library files

license License files

lil Loadable library files

merant ODBC driver and related files

messages Description files for messages and exceptions

migration Migration files

ODBC32 Sample 32-bit ODBC configuration files

readmes Product readme files

sample C, C++, and Java sample files

SecurityProviders Security files

webservices Web Services files
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Directories under install_dir

Contents

xIxpc

Product library files

xml4c

XML processing files

The default work directory is /var/mqsi/. The directories created are shown in the

following table.

Directories under /var/mqsi | Contents
common/errors Error files
common/locks Resource locks
common/log Trace files
common/profiles User profiles
components Component details
config Profiles

odbc ODBC files

registry Registry information
shared-classes User installed user-defined node classes
XML XML files

XSL XSL style sheets

Message Broker Toolkit

The default IBM Installation Manager installation directory is /opt/ibm/
InstallationManager. The default Shared Resources Directory is
/opt/ibm/SDP70Shared. The default package group directory is
/opt/IBM/WMBT610. These directories are defined and described in the

[“Installation Guide” on page 3|

The directories created are shown in the following tables.

Directories under
/opt/ibm/InstallationManager

Contents

eclipse

Eclipse plug-in directories and files

license

License files

Directories under

/opt/ibm/SDP70Shared Contents

atoc Eclipse plug-in directories and files

extra License files

features Product files for features installed on this computer
native

plugins Eclipse plug-in directories and files common to features

installed on this computer
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Directories under

lopt/IBM/WMBT610 Contents

bin Directories and files for products within the package group
configuration Configuration files

eclipse Eclipse files

features Directories and files for products within the package group
jdk Java directories and files

lum License files

plugins Eclipse plug-ins and related files

ResourceAdapters Rational directories and files

runtimes Rational directories and files

samples Sample response files

uninstall Product uninstall files

wmbt Message Broker files

Other files are also stored by the Installation Manager in the directory
/var/ibm/InstallationManager.

Windows

On this platform, you can install both the runtime components and the Message

Broker Toolkit.

Runtime components

On Windows, the default home directory install_dir is C:\Program
Files\IBM\MQSI\6.1. The directories created in install_dir are shown in the

following table.

Directories under install_dir | Contents

_uninst_runtime Uninstall programs

_uninst_runtime_jvm Uninstall programs (JVM)

adapters WebSphere Adapters files

bin Executable binaries

catalina Web Services support files

classes Java class files

DataDirect ODBC driver and related files

docs Java API files

exmltConfig XML transformation files

include Header and other files for samples

itlm Tivoli License Manager files

jplugin Java plug-in files

jreld IBM Runtime Environment for the Java Platform Version 5
(also known as Version 1.5)

lib Shared library files

license License files
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Directories under install_dir | Contents

messages Description files for messages and exceptions
migration Migration files

readmes Product readme files

sample C, C++, and Java sample files

webservices Web Services files

The default working directory is %ALLUSERSPROFILE%\ Application
Data\IBM\MQSI where %ALLUSERSPROFILE% is the environment variable that
defines the system working directory. The default value of ALLUSERSPROFILE% is
C:\Documents and Settings\ All Users; this setting might have a different value on
your computer, but the remainder of the product working directory path is fixed.
The directories created are shown in the following table.

Directories under work_dir Contents
Common/dbinstmgr Derby database files
Common/errors Error files
Common/locks Resource locks
Common/log Trace files
Common/profiles User profiles
components Component details
odbc ODBC files

registry Registry information
shared-classes User installed user-defined node classes
XML XML files

XSL XSL style sheets

Message Broker Toolkit

On Windows, the default IBM Installation Manager installation directory is
C:\Program Files\IBM\InstallationManager. The default Shared Resources
Directory is C:\Program Files\IBM\SDP70Shared. The default package group
directory is C:\Program Files\IBM\IBM\WMBT610. These directories are defined

and described in the [“Installation Guide” on page 3|

The directories created are shown in the following tables.

Directories under

C:\Program

Files\IBM\

InstallationManager Contents

eclipse Eclipse plug-in directories and files
license License files

Directories under
\SDP70Shared

Contents

atoc

Eclipse plug-in directories and files
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Directories under

\SDP70Shared Contents

extra License files

features Product files for features installed on this computer
native

plugins Eclipse plug-in directories and files common to features

installed on this computer

Directories under

\WMBT610 Contents

bin Eclipse plug-in directories and files

configuration License files

features Product files for features installed on this computer

jdk Java directories and files

lum License files

plugins Eclipse plug-in directories and files common to features
installed on this computer

ResourceAdapters Rational directories and files

runtimes Rational directories and files

samples Sample response files

uninstall Product uninstall files

wmbt Message Broker files

Other files are also stored by the Installation Manager in the directories
C:\Documents and Settings\Al1l Users\Application Data\IBM\Installation
Manager and C:\Documents and Settings\Administrator\IBM\
InstallationManagerInstaller. Your system might have a different value for
Documents and Settings, but the remainder of these paths are fixed.

z/0S

The default installation directory is /usr/lpp/mgqsi/VxRxMx where VxRxMx
represents Version X, Release X, Modification X, for example, V6R1IMO.

For more details of locations, libraries, and file system paths, see the Program
Directory for WebSphere Message Broker for z/OS or the Program Directory for
WebSphere Message Broker with Rules and Formatter for z/OS.

Registry changes created by installation and configuration

When you install WebSphere Message Broker, the installation program creates a
number of entries in a registry. Further changes are made by some configuration

updates (for example, when you create a broker).
Runtime components
On Windows, the system registry is used; on Linux and UNIX systems, equivalent

values are stored within the installation directory structure. Do not alter or remove
these entries unless instructed to do so by IBM Service.
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The table below describes the main Windows registry entries. These entries are
created under HKEY LOCAL_MACHINE\SOFTWARE\IBM\WebSphereMQIntegrator.

Location

Description

component_name

Top level entry for each component that you have
installed and configured.

component_name\CurrentVersion\DataSourceName

Name of database for this component.

component_name\CurrentVersion\FADLevel

Formats and data version; contents depend on service
installed. FADLevel does not necessarily change with
each product update.

component_name\CurrentVersion\QueueManagerName

Name of queue manager for this component.

Entries are also created under HKEY LOCAL MACHINE\SOFTWARE\ODBC\ODBCINST.INI
for the installed database drivers for Oracle and Sybase, which contain driver

locations and parameters.

An entry is added under HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\
Services\Eventlog\Application\WebSphere Broker v#** for Event Log
information, where v#** is the current three-digit product version number.

Message Broker Toolkit

All registry entries are controlled by Installation Manager. On Windows, the
system registry is used; on Linux (x86 platform), equivalent entries are stored in
/var/ibm/InstallationManager/. Do not alter or remove these entries unless
instructed to do so by your IBM Service representative.

The installation directory for Installation Manager is stored in
HKEY_LOCAL_MACHINE\SOFTWARE\IBM\Installation Manager under the location

value.

Uninstall keys are created for all products that are installed by Installation
Manager under HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\Current\
Version\Uninstal1\IBM Installation Manager, under the name
IM-packagegroupname where packagegroupname is the name of the package group in
which the product is installed; for example, IBM Software Development Platform.

Environment variables after installation

On distributed systems, ensure that your environment is set up correctly.

If you have installed on z/OS, see [Customizing the z/OS environment]

Sample profile files are provided with WebSphere Message Broker; check their
content to ensure the variables are set correctly for your environment before you
use the product or configure any resources.

* On Linux and UNIX systems, the profile is install_dir /bin/mgsiprofile.

* On Windows systems, a command console is set up when you install
components. Access this through the Start menu. When you select this option, a
command window containing the correct environment is opened.

If you prefer, run install_dir\bin\mgsiprofile.cmd in a command window before
working with WebSphere Message Broker in the same command window.
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If you have more than one installation on a single system, ensure that you run the
correct profile, or access the correct command console, for the installation that you
want to work with. If an installation is at Version 5.0 or Version 6.0, the profile is

incompatible with the Version 6.1 profile. You must log off and log on again before

you run a second profile.

Check the readme file (readme.html) to ensure that you have the latest version of

the profile.

Default WebSphere MQ resources created during installation

and configuration

When you install WebSphere Message Broker and create components,
WebSphere MQ resources are created for use by those components.

The names of these resources begin with the reserved characters SYSTEM. The
resources are additional to the default WebSphere MQ objects that are created
when you install that product. The following table lists the resources and indicates
the component queue manager with which they are associated.

Resource name

Type

Queue
manager

Description

SYSTEM.BROKER.ADMIN.QUEUE

Queue

Broker

Target for messages sent by
the Configuration Manager
and by commands to
modify the broker’s
configuration and
operation.

SYSTEM.BROKER.ADMIN.REPLY

Queue

Configuration
Manager

Target for response
messages that the broker
sends to the Configuration
Manager.

SYSTEM.BROKER.AGGR.CONTROL

Queue

Broker

Used internally to store a
control message for each

aggregate group.

SYSTEM.BROKER.AGGR.REPLY

Queue

Broker

Used internally to store
each known response
message received by an
AggregateReply node.

SYSTEM.BROKER.AGGR.REQUEST

Queue

Broker

Used internally to store
each request message that
forms part of an aggregate

group.

SYSTEM.BROKER.AGGR. TIMEOUT

Queue

Broker

Used internally in the
timeout and unknown
timeout processing within
an AggregateReply node.

SYSTEM.BROKER.AGGR.UNKNOWN

Queue

Broker

Stores each unknown
response received by an
AggregateReply node.

SYSTEM.BROKER.CONFIG.QUEUE

Queue

Configuration
Manager

Target for messages that the
toolkit sends to the
Configuration Manager.
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Resource name

Type

Queue
manager

Description

SYSTEM.BROKER.CONFIG.REPLY

Queue

Configuration
Manager

Target for messages that the
Configuration Manager
sends to the toolkit.

SYSTEM.BROKER.CONTROL.QUEUE

Queue

Broker

Target for
publish/subscribe control
requests that applications
send to the broker.

SYSTEM.BROKER.EDA.COLLECTIONS

Queue

Broker

Used internally to store
event handler information
for message collections
generated by the Collector
node.

SYSTEM.BROKER.EDA .EVENTS

Queue

Broker

Used internally to store
messages received by the
Collector node.

SYSTEM.BROKER.EXECUTIONGROUP.QUEUE

Queue

Broker

Target for messages that the
broker’s internal
AdminAgent component
sends to execution groups.

SYSTEM.BROKER.EXECUTIONGROUP.REPLY

Queue

Broker

Target for response
messages that execution
groups send to the broker’s
internal AdminAgent
component.

SYSTEM.BROKER.INTER.BROKER.COMMUNICATIONS

Queue

Broker

Target for
publish/subscribe control
messages.

SYSTEM.BROKER.INTERBROKER.MODEL.QUEUE

Queue

Broker

Model for dynamic
publication queues.

SYSTEM.BROKER.INTERBROKER.QUEUE

Queue

Broker

Target for
publish/subscribe messages
sent by neighbor brokers.

SYSTEM.BROKER.IPC.QUEUE

Queue

Broker

Target for internal control
messages.

SYSTEM.BROKER.MODEL.QUEUE

Queue

All

Model for dynamic
response queues.

SYSTEM.BROKER.SECURITY.QUEUE

Queue

User Name
Server

Target for messages that the
Configuration Manager,
brokers, and the toolkit
send to the User Name
Server.

SYSTEM.BROKER.SECURITY.REPLY

Queue

Configuration
Manager and
brokers

Target for response
messages that the User
Name Server sends to its
requestor.

SYSTEM.BROKER. TIMEOUT.QUEUE

Queue

Broker

Used internally to support
the TimeoutControl and
TimeoutNotification nodes.

SYSTEM.BROKER.WS.ACK

Queue

Broker

Used internally for Web
Services client support.
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Resource name Type Queue Description
manager
SYSTEM.BROKER.WS.INPUT Queue Broker Used internally for Web
Services client support.
SYSTEM.BROKER.WS.REPLY Queue Broker Used internally for Web
Services client support.
SYSTEM.BKR.CONFIG SVRCONN | Configuration | A connection channel for
Manager toolkit clients.
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Appendix. Notices for WebSphere Message Broker
This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this information
in other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this information. The furnishing of this information does not give you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing

2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032,

Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the information. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
information at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.

© Copyright IBM Corp. 2000, 2007 69



IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM United Kingdom Laboratories,
Mail Point 151,

Hursley Park,

Winchester,

Hampshire,

England

5021 2]JN

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this information and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Programming License Agreement, or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM’s future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

This information includes examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
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been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs.

Each copy or any portion of these sample programs or any derivative work, must
include a copyright notice as follows:

(C) (your company name) (year). Portions of this code are derived from IBM Corp.
Sample Programs. © Copyright IBM Corp. _enter the year or years_. All rights
reserved.

Trademarks in the WebSphere Message Broker information center

The following terms are trademarks of International Business Machines
Corporation in the United States, other countries, or both:

AIX CICS DB2
DB2 Connect DB2 Universal Database developerWorks
Domino Everyplace
FEST First Failure Support IBM
Technology
IBMLink IMS IMS/ESA
iSeries Language Environment Lotus
MQSeries MVS NetView
0S/400 0S5/390 POWER
pSeries RACF Rational
Redbooks RETAIN RS/6000
SupportPac S/390 Tivoli
VisualAge WebSphere xSeries
z/0S zSeries

Java and all Java-based trademarks and logos are trademarks of Sun Microsystems,
Inc. in the United States, other countries, or both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both.

Intel and Pentium are trademarks or registered trademark of Intel Corporation or
its subsidiaries in the United States and other countries.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Linux is a trademark of Linus Torvalds in the United States, other countries, or
both.

Other company, product, or service names may be trademarks or service marks of
others.
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